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1 Introduction
Microsoft, Microsoft Edge, Windows and Windows Server are trademarks or registered trademarks of Micro-
soft Corporation in the United States and other countries.

Apple, iPhone, AirPrint, iPad, Bonjour, macOS, and Mac are trademarks of Apple Inc., registered in the U.S. 
and other countries.

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

Android and Google Play are trademarks of Google LLC.

Mopria and the Mopria logo are registered trademarks and service marks of Mopria Alliance, Inc. in the United 
States and other countries. Unauthorized use is strictly forbidden.

Wi-Fi and Wi-Fi Direct logo are registered trademarks or trademarks of Wi-Fi Alliance.

Other company names or product names are trademarks or registered trademarks of their respective com-
panies.

Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

Items in this manual displayed with the  mark are cautions to promote safe use. Be sure to read them be-
fore operation, and to follow instructions.

Using a printer for illicit printing, including printing currency or negotiable instruments, is a punishable viola-
tion of the law regardless of whether or not the printed output is used.

We are not responsible for any breakdown of machines due to infection of computer virus or computer hack-
ing.

Important

- Do not edit, alter or indiscriminately reprint this manual.

- The content of this manual may be changed in the future without notice.

- Each illustration included in this manual shows only one example. Variations may occur, depending on 
the device, software and OS version you are using.

KONICA MINOLTA, the KONICA MINOLTA logo, Giving Shape to Ideas, and bizhub are registered trade-
marks or trademarks of KONICA MINOLTA, INC.
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2.1 Types of Manuals 2

2 Before Beginning

2.1 Types of Manuals

2.1.1 User's Guide (this manual)
Describes how to use the print function, various operator panel menu items, troubleshooting tips, and routine 
management.

NOTICE
Available in English, German, French, Spanish and Italian.

Tips
- Optional accessories are available for the machine. Depending on the product, a manual describing 

procedures such as installation may be included.

2.1.2 Quick Guide
This is a description of the basic operation procedures of this machine and the precautions for using this ma-
chine safely.

2.1.3 General Safety Information/Setup Guide
In order to operate the machine safely and properly, be sure to read the safety information in this manual be-
fore use:

- Items that must be observed to use the machine safely

- Information regarding product safety

- Precautions when using the machine

- Descriptions on trademarks and copyrights
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2.2 Conventions
Please note that the screenshots shown in this manual apply to a fully configured machine and therefore may 
not exactly represent the configuration being used.

This manual uses the following symbols:

NOTICE
Indicates important information you have to know or be reminded before operations.

Tips
- Indicates supplemental information useful for operations.

dReference
Indicates reference sections or documents.

Orientation of paper is described in this manual as follows:

- The display shows v, LEF orientation: Loading paper v in portrait orientation.

- The display shows w, SEF Orientation: Loading paper in w landscape orientation.

The content of this manual is subject to change without notice. For the latest information, access the Konica 
Minolta web site in your region, or contact your supplier.

Unless otherwise specified, the operations demonstrated in this manual using computers describe proce-
dures for Microsoft Windows 10 and macOS 10.15.

"WSD" is an abbreviation of "Web Services on Devices".

"WIA" stands for "Windows Image Acquisition".

Symbols/Notations Description

" " Entered characters and the names of features are displayed.

[ ] An item enclosed by brackets [ ] indicates a key name on the ma-
chine's display or computer screen, or the name of a user's guide.

< > Indicates hardware buttons on the operator panel.
Indicates keys on the keyboard of the computer.
Indicates variables.

> Indicates an abbreviated process flow on the operator panel or 
the computer.

Bold text This presents a key name, part name, product name, or option 
name.
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2.3 About the Machine 2

2.3 About the Machine
In order to use the machine more securely, connect to networks with firewall or other protection and configure 
security settings appropriately.

Optional accessories may be necessary, depending on the function. For details, contact your service repre-
sentative.

Items appearing on the display will vary depending on installed options.

Some features may be unavailable for use depending on country or territory.
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2.4 Machine Overview

2.4.1 Machine Main Unit

Front and Right Sides

*1: This feature can be pulled out for use when printing on paper sizes larger than A4 or for high-volume print-
ing.

No. Name

 1 Operator Panel

 2 Right Side Cover

 3 Tray 2 (Paper Feed Unit PF-P26) (optional)

 4 Tray 1 (Standard Tray)

 5 Bypass Tray

 6 Output Extension Tray *1

3

4

5

6

1

2
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2.4 Machine Overview 2

Left Side and Rear

Tips
The network port of this product is following No.1 and No.2. A port is activated when a network port inserts 
a cable.

Internal View

No. Name

 1 USB Port

 2 Ethernet Port

 3 Kensington Security Slot

 4 Power Supply Cord Socket

 5 Fusing Unit

 6 Rear Cover

3

4

5

6 1

2

No. Name

 1 Drum Cartridge

 2 Toner Cartridges

 3 Waste Toner Box

3

2

1
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2.4.2 Operator Panel

No. Name Description

 1 NFC Touch Area Hold the mobile device over the machine to start communication 
between it and the machine through the NFC feature.

 2 Display Display various settings, instructions and error messages.

 3 <WPS> button Start configuring connection to a wireless network through Wi-Fi 
Protected Setup (PBC protocol).

 4  (Power Supply / 
Power Saver) button

• Turns on/off the machine.
• Switches the machine between two modes: Standby and 

Power Saver. Blinks slowly when the machine is in Power Sav-
er Mode.

dReference
For details on how to turn the power supply on or off, 
refer to page 3-3.

For details on power saving features, refer to page 4-5.

 5 + , * )button Scroll and select menus or settings values in the Menu screen. 
Use to enter numerals or passwords.

 6  <Cancel Job> but-
ton

Stop print jobs or cancel entered data.

 7 Ready LED Illuminates when the machine is standing by, blinks when it is pro-
cessing data.

 8 Status LED • Blinks in green when the machine starts, when a job is com-
pleted, when an identification signal is received from a mobile 
device, and when an error is cleared.

• Blinks in orange when an error occurs.

 9  <Back> button Returns to the previous screen and cancels the operation.

10  <OK> button Display selected menu items, and confirms selected settings val-
ues.

11  <Menu> button Switch between Print and Menu screens.
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2.5 Symbols Used with the Machine 2

2.5 Symbols Used with the Machine
For details on the meanings of symbols, refer to the following.

Symbol Description

Cautions, hazards and warnings

Caution: high temperature

Disassembly prohibited

Follow instructions

Do not throw into open flame

Do not touch the light-sensitive part of drum cartridge.

Do not throw drum cartridge into open flame

Do not throw waste toner box into open flame

Do not place waste toner box upside-down

Do not expose drum cartridge to light.

Power On/Off

Do not use inkjet paper
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Symbols Used with the Machine2 2.5

Do not use creased, wrinkled or curled paper

Do not use OHP film

Do not use the back side of paper (printed on by another machine)

Paper

Envelope

Load paper with the side you want to print on facing up

Maximum load

Load paper

Paper jam

LAN

USB

Cooling

Elapsed time

Symbol Description
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3.1 Turning On/Off the Machine 3

3 Setting Up the Machine

3.1 Turning On/Off the Machine

3.1.1 Turning On the Machine

% Press the  (Power Supply / Power Saver) button.
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Turning On/Off the Machine3 3.1

Setting Up Initial Settings of the Machine
When turning on the machine for the first time, screen to set the initial settings of the machine will be dis-
played.

1 Press the + or , button to select a language, then press the  button.

2 Press the  button.

3 You can change the machine administrator's password for Internet Services.

% The machine administrator's default password is the 13-digit serial number indicated on the back 
of the machine. Follow the on-screen instructions to enter the current password (serial number), a 
new password containing at least 4 digits, and the same new password again.

% You can also select [Skip] with the + or , button and change the password later. If you select [Skip], 
the machine administrator's password can only be changed from the Internet Services.

4 Press the  button.

dReference
For details on Internet Services, refer to page 8-3.

3.1.2 Turning Off the Machine
NOTICE
The print data in the memory is cleared when the machine is turned off.

1 Press the  (Power Supply / Power Saver) button.

2 Make sure that [Power Off] appears on the display, and press the  button.

Serial No. : XXXXXXXXXXXXX
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3.2 Connecting the Machine to a Computer
The machine can connect with wired network, USB, and wireless network connections. After connecting, in-
stall print driver and other necessary software.

3.2.1 Connecting to a Wired (Ethernet) Network

Tips
- Use a LAN cable that is category-5 or greater.

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Network], and press the  button.

4 If [Wi-Fi] is selected, press the + or , button, select [Ethernet], and press the  button.

% If [Ethernet] is selected, proceed to step 6.

5 If a confirmation screen appears, turn off the machine, and then turn it on again.

6 Insert the network cable into the machine's Ethernet port.

7 Connect a hub or other network device to the other network cable port.

8 Set the IP address for the machine.

dReference
For details on how to configure IP addresses, refer to page 3-11.
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3.2.2 Connecting to a Computer With USB

1 Press the  (Power Supply / Power Saver) button, make sure that [Power Off] is displayed, and 
press the  button.

2 Insert the USB cable in the machine's (upper) USB port.

NOTICE
Do not connect the machine to a USB hub.

3 Connect the computer with the other USB cable port.

4 Press the  (Power Supply / Power Saver) button to turn the power on.
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3.2.3 Connecting to a Wireless Network

Preparing to Use a Wireless Network
Perform the following procedures before configuring the wireless settings.

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Network], and press the  button.

4 If [Ethernet] is selected, press the + or , button, select [Wi-Fi], and press the  button.

% If [Wi-Fi] is selected, proceed to wireless network connections.

5 If a confirmation screen appears, turn off the machine, and then turn it on again.

Wi-Fi settings can be configured as follows.

dReference
Automatically Connecting to a Wireless Network (page 3-7)

Manually Connecting to a Wireless Network (page 3-8)

Connecting Using [Quick Setup] (Windows) (page 3-10)

Connecting Using Support Tools (Windows) (page 3-10)

Automatically Connecting to a Wireless Network
This machine supports wireless LAN connection using WPS (push button method) and WPS (PIN code meth-
od).

- For WPS (push button method), configure the settings on the operator panel, and then press the WPS 
button on your access point or wireless router.

- For WPS (PIN code method), enter the PIN code assigned to the machine into the access point or wire-
less router.

These methods are available only when the access point or wireless router supports WPS.

dReference
For details about the WPS operation on the access point or wireless router, see the manual supplied with the 
access point or wireless router.

When Connecting With WPS (push button method)

1 When [Press WPS Button on router] appears on the display, press the <WPS> button.

2 Press the WPS button at the wireless network access point within two minutes.

When connection to an access point or wireless router is complete, the machine will restart automati-
cally.

Tips
You can perform the same settings configuration from the settings menu. For details, refer to page 7-10.
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When Connecting With WPS (PIN code method)

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Wi-Fi], and press the  button.

4 Press the + or , button, select [WPS Setup], and press the  button.

5 Press the + or , button, select [PIN Code], and press the  button.

6 Write down the eight-digit PIN code, or press the + or , button, select [Print PIN Code], and press the 
 button to print the PIN code.

7 Specify a PIN code for the wireless network access point.

8 Press the + or , button, select [Start Configuration], and press the  button.

A "Operate Wireless Router" message appears.

When connection to an access point or wireless router is complete, the machine will restart automati-
cally.

dReference
For details about how to enter the PIN code, see the manual supplied with the access point or wireless router.

Manually Connecting to a Wireless Network
Connect to a wireless network by selecting your access point or wireless router from the list or by specifying 
the SSID.

Tips
- You need the SSID and the WEP key or passphrase of the access point or wireless router. For details, 

see the manual supplied with the access point or wireless router.

When Connecting by Selecting an Access Point or Wireless Router

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Wi-Fi], and press the  button.

4 Press the + or , button, select [Wi-Fi Setup], and press the  button.

5 Press the + or , button, select a wireless network access point to connect to, and press the  button.

% If the wireless network access point does not appear, specify the SSID by entering it manually. For 
details, refer to page 3-9.

6 Enter the WEP key or passphrase, and press the  button.

When connection to an access point or wireless router is complete, the machine will restart automati-
cally.
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When Connecting by Entering the SSID Manually

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Wi-Fi], and press the  button.

4 Press the + or , button, select [Wi-Fi Setup], and press the  button.

5 Press the + or , button, select [Manual Setup], and press the  button.

6 Enter the SSID, and press the  button.

7 Press the + or , button, select [Infrastructure] or [Ad-hoc] depending on the environment you are using, 
then press the  button.

NOTICE
If [Wi-Fi Direct] is enabled, [Ad-hoc] cannot be used.

8 Press the + or , button to specify the encryption type.

9 Enter the WEP key or passphrase as needed, and press the  button.
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Connecting Using [Quick Setup] (Windows)
Using [Printer Software], [Quick Setup] makes wireless network connections easy to set up. Using [Quick Set-
up], when you connect to a network, you can handle the software installation at the same time.

To install [Printer Software], access the Konica Minolta web site in your region, or contact your supplier.

You can use [Quick Setup] to connect to a wireless network when the following conditions are met.

- Your computer is connected to the access point or wireless router that you want to set on the machine.

- The machine is not connected to another wireless network.

Tips
- Depending on the environment you are using, there may be cases in which you cannot use [Quick Set-

up] to connect to a wireless network.

- When specifying the encryption type as WEP and connecting to a wireless network, [Quick Setup] can-
not be used. Configure the wireless network settings from the operator panel and install the software 
with [Custom Installation]. For details on wireless network connection settings, refer to page 3-8 and 
for details on how to install software, refer to page 3-15.

dReference
For details on connecting and installing software using [Quick Setup], refer to page 3-13.

Connecting Using Support Tools (Windows)
You can use the [Printer Software] support tool to configure wireless network settings. You can connect to a 
wireless network with the support tools when the following conditions are met.

- Your computer is connected to the access point or wireless router that you want to set on the machine.

- The machine is not connected to another wireless network.

1 Extract [Printer Software] after downloading to the computer, and double-click on "Launcher.exe" in 
the generated folder.

2 Click on [Support Tools].

3 Click on [Wi-Fi Settings].

4 Follow the on-screen instructions to configure the settings.
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3.2.4 Setting the IP Address
This section describes how to set/change the IP address.

Tips
- When specifying an IP address for an IPv6 environment, use the [Printer Software] support tool or In-

ternet Services. For details on support tools, refer to page 3-12. For details on Internet Services, refer 
to page 8-3.

Setting the IP Address From the Operator Panel

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Ethernet] or [Wi-Fi], and press the  button.

4 Press the + or , button, select [IP Mode], and press the  button.

5 Press the + or , button, select [Dual Stack], [IPv4] or [IPv6], and press the  button.

% Even if a message appears with the option to restart the machine, proceed to the following step 
without turning off the power.

6 Press the  <Back> or * button twice.

7 Press the + or , button, select [TCP/IP], and press the  button.

8 Press the + or , button, select [IP Addressing], and press the  button.

9 Specify the IP address.

% To set the IP address automatically

1. Press the + or , button, select [DHCP / Autonet], [BOOTP] or [DHCP], and proceed to step 10.

% To set the IP address manually

1. Press the + or , button, select [Manual Input], and press the  button.
Even if a message appears with the option to restart the machine, proceed to the following step without 
turning off the power.

2. Press the  <Back> or * button twice.

3. Press the + or , button, select [IP Address], and press the  button.

4. Enter the IP address and press the  button.
Even if a message appears with the option to restart the machine, proceed to the following step without 
turning off the power.

5. Press the  <Back> or * button twice.

6. Press the + or , button, select [Subnet Mask], and press the  button.

7. Enter the subnet mask and press the  button.
Even if a message appears with the option to restart the machine, proceed to the following step without 
turning off the power.

8. Press the  <Back> or * button twice.

9. Press the + or , button, select [Gateway Address], and press the  button.

10. Enter the gateway address and press the  button.

10 Turn off the machine, and then turn it on again.
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Configuring Settings with [Support Tools] (Windows)

1 Extract [Printer Software] after downloading to the computer, and double-click on "Launcher.exe" in 
the generated folder.

2 Click on [Support Tools].

3 Click on [IP Address Settings].

4 Follow the on-screen instructions to configure the settings.

Checking the IP Address
You can check the settings by using the operator panel, or by printing the System Settings report.

Using the Operator Panel

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Ethernet] or [Wi-Fi], and press the  button.

4 Press the + or , button, select [TCP/IP], and press the  button.

5 Press the + or , button, select [IP Address], and press the  button.

6 Confirm the IP address shown in the display.

Using the Printer Settings Report

1 Print the Printer Settings report.

% For details on how to print reports and lists, refer to page 7-3.

2 Confirm the IP address listed in the report.
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3.2.5 Installing Software for Windows
To install the latest Windows version of [Printer Software], access the Konica Minolta web site in your region, 
or contact your supplier.

Tips
Perform the following procedure in advance, and then start installing.

- Connecting to a Wired (Ethernet) Network (page 3-5)

- Connecting to a Computer With USB (page 3-6)

- Preparing to Use a Wireless Network (page 3-7)

Using [Printer Software]
You can use the [Printer Software] to configure the following features.

No. Name Description

 1 [Quick Setup] You can install the basic software bundle used with the machine. 
When using a wireless network, you can obtain the software in one 
installation by connecting to the network.
The following software can be installed:
• [PCL Driver]
• [Print & Scan Hub]

dReference
For details on the installation method, refer to 
page 3-15.

For details on Print & Scan Hub, refer to page 8-5.

 2 [Custom Installation] > [Driv-
er]

You can select and install only the drivers that you need.
The following drivers can be installed:
• [PCL Driver]
• [PS Driver]

dReference
For details on the installation method, refer to 
page 3-15.

1 2 3 4 5 6 7
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 3 [Custom Installation] > 
[Software]

You can select and install only the software that you need.
The following software can be installed:
• [Print & Scan Hub]

dReference
For details on the installation method, refer to 
page 3-15.

For details on software, refer to page 8-5.

 4 [Support Tools] > [Create 
Driver Setup Disk]

You can create a setup disk for the drivers. Using the setup disk 
reduces the amount of work required when installing drivers on 
multiple computers with the same settings.

dReference
The setup disk cannot be used with a computer that 
runs an OS which differs from that of the computer that 
created the disk. Create setup disks for each OS.

 5 [Support Tools] > [IP Ad-
dress Settings]

You can configure the IP address settings.

dReference
For details on the configuration method, refer to 
page 3-12.

 6 [Support Tools] > [Wi-Fi Set-
tings]

You can configure the wireless LAN settings for the machine and 
your computer.

dReference
For details on how to configure settings, refer to 
page 3-10.

 7 [Media Information] You can check the content recorded in [Printer Software].

No. Name Description
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Installing with [Quick Setup]

1 Extract [Printer Software] after downloading to the computer, and double-click on "Launcher.exe" in 
the generated folder.

2 Click on [Quick Setup].

3 Follow the on-screen instructions to complete the setup.

Installing with [Custom Installation]

1 Extract [Printer Software] after downloading to the computer, and double-click on "Launcher.exe" in 
the generated folder.

2 Click on [Driver] or [Software].

% If [Software] is selected, proceed to step 5.

3 Select [I accept the terms of the license agreement], and click on [Next].

4 Select your connection method and click on [Next].

5 Follow the on-screen instructions to complete the setup.
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3.2.6 Installing Software for Mac
To install the latest software for Mac, access the Konica Minolta web site in your region, or contact your sup-
plier.

Installing Software

1 Download software to your computer.

2 Double-click on the downloaded dmg file.

3 Double-click the pkg file in the folder.

4 Follow the on-screen instructions to complete the setup.

Registering the Machine in a Mac

Adding the Machine Using USB Connection

1 Turn on the machine.

2 Connect the USB cable to the machine and your computer.

3 From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

4 If the machine appears in [Printers], then registration is complete.

% If the machine is not displayed, add the machine following step 5 and the steps that follow.

5 Click on .

6 In the [Kind] column, select the name for the machine displayed as [USB] from [Name].

7 From [Use], select a driver compatible with the machine.

8 Click on [Add].

9 Make sure that the machine is displayed in [Printers].
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Adding a Machine Using LPD Connection

1 Turn on the machine.

2 Make sure that your computer and the machine are connected.

% If you use a wired connection, connect the machine to the network using an Ethernet cable.

% If you use a wireless connection, make sure that the wireless connection of your computer and the 
machine are established properly.

3 From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

4 Click on .

5 Click on [IP].

6 From [Protocol], select [Line Printer Daemon-LPD].

7 Enter the machine's IP address in [Address].

8 From [Use], select a driver compatible with the machine.

9 Click on [Add].

10 Specify an optional accessory already installed on the machine, and click [OK].

11 Make sure that the machine is displayed in [Printers].

Adding the Machine Using Bonjour

1 Turn on the machine.

2 Make sure that your computer and the machine are connected.

% If you use a wired connection, connect the machine to the network using an Ethernet cable.

% If you use a wireless connection, make sure that the wireless connection of your computer and the 
machine are established properly.

3 From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

4 Click on .

5 From [Name], select the name for the machine displayed as [Bonjour] in the [Kind] column.

6 From [Use], select a driver compatible with the machine.

7 Click on [Add].

8 Specify an optional accessory already installed on the machine, and click [OK].

9 Make sure that the machine is displayed in [Printers].

Enabling Optional Accessories
On the driver, specify the optional accessories installed on the machine to enable the associated features.

1 From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

2 From [Printers], select this machine, and click on [Options & Supplies].

3 Click on [Options].

4 Select an optional accessory already installed on the machine, and click [OK].
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4 Using Your Machine

4.1 Using the Operator Panel
The operator panel comprises the display, Status LED, Ready LED,  (Power Supply / Power Saver) but-
ton, <WPS> button,  <Menu> button, NFC touch area and  <Back> button, etc.

dReference
For details on the Operator Panel, refer to page 2-8.

4.1.1 Display Screens
There is a Print screen, which shows the status of the machine, and a Menu screen, for configuring the ma-
chine's settings.

Tips
Messages appearing on the display will vary depending on options installed on the machine and settings con-
figuration.

Print Screen
Displays the status of the machine. When ready or printing, the Print screen display will appear as follows.

Tips
-  When connected via Wi-Fi, and  when connected by Ethernet.

- Remaining toner content marking will appear as follows. When the remaining toner content reaches 
0%, an error message will appear.

Remaining toner 
content
100 - 81%

Remaining toner 
content
80 - 61%

Remaining toner 
content
60 - 46%

Remaining toner 
content
45 - 31%

Remaining toner 
content
30 - 1%

Machine Status (Stand-by) LED Status

Toner Level (Estimate)

Machine Status (Printing)

Data input port Paper tray
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Menu Screen
This screen is for configuring the machine settings.

dReference
For details on the settings that can be configured in the settings menu, refer to page 7-3.

4.1.2 Changing Language Settings
You can select the language used on the machine.

1 Press the  <Menu> button.

2 Press the + or , button, select [Language], and press the  button.

3 Select the language you wish to set, and press the  button.

4.1.3 Limiting Access to Features
You can use passcodes to limit access to each feature. This prevents unauthorized users from operating the 
machine.

Access restrictions can be applied to the following features:

- [Information Pages]

- [General]

- [Network Settings]

- [Security Settings]

- [Maintenance]

- [Advanced Settings]

1 Press the  <Menu> button.

2 Press the + or , button, select [Security Settings], and press the  button.

3 Press the + or , button, select [Admin Authentication], and press the  button.

4 Select [Admin Authentication], and press the  button.

5 Press the + or , button, select [On], and press the  button.

6 Enter the 4 digit passcode and press the  button.

7 Re-enter the passcode and press the  button.

Access to the relevant feature is restricted so that passcode entry is necessary to operate it.
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4.2 Power Saver Mode
The machine is equipped with power saving features that reduce electric power consumption volume to con-
serve electricity.

Power saving features include Low Power Mode and Sleep Mode.

Sleep Mode reduces electric power consumption even more than Low Power Mode, but requires a longer 
recovery period than Low Power Mode.

4.2.1 Switching to Power Saver Mode
The machine enters Power Saver mode in the following cases. In Power Saver mode, the  (Power Sup-
ply / Power Saver) button blinks.

- Press the  (Power Supply / Power Saver) button, and select [Power Saver On]

- When the machine has not been operated, no jobs have been executed, and no print data has been 
received until it is time for the machine to enter Power Saver Mode

Tips
The machine will not enter Power Saver Mode while an error message is displayed for paper jams, consum-
ables replacement, etc.

dReference
For details on how to change the interval until the machine enters Power Saver Mode, refer to page 4-6.

4.2.2 Recovering From the Power Saver Mode
The machine recovers from Power Saver Mode with the following procedure or state.

- When the  (Power Supply / Power Saver) button is pressed

- When the machine receive jobs

Tips
- When you press the  (Power Supply / Power Saver) button immediately after the display turns 

off, or when the machine has not completely entered Power Saver mode, leaving Power Saver mode 
may take some time. Wait until the machine accepts the operation releasing it from Power Saver mode, 
then press the  (Power Supply / Power Saver) button again.

- When jobs are executed in Power Saver Mode, it sometimes switches to Power Saver Mode earlier than 
specified by the settings.
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4.2.3 Setting the Power Saving Features

1 Press the  <Menu> button.

2 Press the + or , button, select [General], and press the  button.

3 Press the + or , button, select [Power Saver], and press the  button.

4 Press the + or , button, select [Low Power Timer] or [Sleep Timer].

5 Press the + or , button, and specify a numerical value.

6 Press the  button.

Tips
- In some areas, you can set [Power Off Timer] in addition to [Low Power Timer] and [Sleep Timer]. If you 

select [Enable] in [Power Off Timer], the power is turned off automatically after the time period specified 
in [Time] has elapsed. If [Auto Detect] is selected, the same operation as [Enable] is applied only when 
it is judged that neither the network cable nor the USB cable is connected. When [Disable] is selected, 
this function is disabled.

4.3 Print Media Guidelines

Tips
For details on paper that can be used, contact your service representative.

4.3.1 Feed Performance for Each Tray

*1: For 21.28 lb (80 gsm) paper
*2: Envelopes only, up to 8.66" (220.0 mm)

NOTICE
The presence of water, rain, steam or other moisture may cause images to come off of the print surface. For 
details, contact your service representative.

Tips
- Envelopes can be loaded into the trays to the following stack heights (envelope counts).

Tray 1: approximately 1.08" (27.5 mm) (20 envelopes)
Bypass Tray: approximately 0.21" (5.4 mm) (5 envelopes)

- The automatic two-sided feature can be used with the following paper sizes and weights.
Width: 5.47 to 8.5" (139.0 to 215.9 mm)
Height: 8.27 to 14" (210.0 to 355.6 mm)
Paper weight: 15.96 to 46.82 lb (60 to 176 gsm)

Paper Tray Supported Paper 
Weight

Paper Size Permissible 
sheet count 
load*1

Tray 1 15.96 to 46.82 lb 
(60 to 176 gsm)

Width: 3 to 8.5" (76.2 to 
215.9 mm)*2 

Height: 5 to 14" (127.0 to 
355.6 mm)

250 sheets

Tray 2 (Paper Feed Unit 
PF-P26) (optional)

15.96 to 46.82 lb 
(60 to 176 gsm)

Width: 3 to 8.5" (76.2 to 
215.9 mm)
Height: 8.27 to 14" (210.0 
to 355.6 mm)

250 sheets

Bypass Tray 15.96 to 46.82 lb 
(60 to 176 gsm)

Width: 3 to 8.5" (76.2 to 
215.9 mm)*2
Height: 5 to 14" (127.0 to 
355.6 mm)

50 sheets



bizhub C3100i 4-7

4.3 Print Media Guidelines 4

Paper That Cannot Be Used
To avoid machine problems, do not use the following print media:

- Inkjet paper

- Heat-sensitive paper / thermal transfer paper

- Textile transfer paper

- Water transfer paper

- Paper with items such as staples, paper clips, ribbons or tape attached

- Windowed envelopes

- Envelopes with protrusions or clasps

- Paper with special surface coatings

- Paper with surfaces that are rough, fibrous or otherwise not smooth

- Paper with inks that deteriorate when exposed to the heat of the fusing process

There are also other types of paper that cannot be used. For details, contact your service representative.

4.3.2 Storing and Handling Print Media

Storing Print Media
Store paper in a cabinet or other location where humidity is low. If the paper absorbs moisture, this could 
cause paper jams and poor print quality.

When the print media package is opened but not used up, store unused print media in the wrapping paper.

Store print media on a flat surface so that the edges do not buckle or curl.

Store print media in places not exposed to direct sunlight.

Handling Print Media
Straighten the edges of the print media stack before loading.

Do not load multiple sizes of paper at the same time.

Flex and fan label sheets before loading, otherwise a paper jam may occur or multiple sheets may be fed at 
a time.



4-8 bizhub C3100i

Loading Print Media4 4.4

4.4 Loading Print Media

4.4.1 Flex and Fan the Paper
Flex and fan the paper well before loading.

1 Hold one end of the paper, and flex and fan as shown in the illustration.

2 Turn the paper over, then flex and fan again.

3 Loosen the paper.

4 Repeat the procedure described above several times, then align the four corners of the paper stack.
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4.4.2 Loading Paper in Tray 1 / Tray 2 (Paper Feed Unit PF-P26) (Optional)
NOTICE
Do not add paper of a different size or type to the paper remaining in the tray. Doing so could cause a paper 
jam or error.

Do not add paper to or remove paper from the paper tray while printing or copying from it. Doing so could 
cause a paper jam.

1 Supporting the paper tray with both hands, pull it out completely.

2 Move the paper guides to the position to fit the paper size.

% When loading legal-sized paper, press and hold the button on the bottom while pulling out the front 
side of the tray.
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3 Place the side you want to print on facing up, and load the paper with its leading edge aligned with the 
interior end of the tray.

NOTICE
Do not load an excessive number of sheets such that the top of the stack is higher than the , mark. 

If paper is curled, flatten it before loading it.

% Misalignment between the paper and paper guide could cause a paper jam. If the paper and paper 
guide are misaligned, readjust the paper guides according to the paper size.

4 Insert the paper tray into the machine main unit, and press it in slowly until it stops.

5 When the paper settings screen appears on the operator panel, press the + or , button to select paper 
size, and press the  button.

6 Press the + or , button to select paper type, and press the  button.
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4.4.3 Loading paper in the Bypass Tray
NOTICE
Do not add paper to or remove paper from the Bypass Tray while printing or copying from it. Doing so could 
cause a paper jam.

Tips
- If the paper jams, load paper one sheet at a time.

1 Open the Bypass Tray.

% Pull out the Extension Tray as needed. When pulling out the Extension Tray, do so slowly.

2 Adjust the paper guides according to the paper size that you want to load.
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3 Place the side on which you want to print facing up, and with the paper aligned, insert until its leading 
edge is lightly stopped.

NOTICE
Do not load an excessive number of sheets such that the top of the stack is higher than the , mark. 

If paper is curled, flatten it before loading it.

% Misalignment between the paper and paper guide could cause a paper jam. If the paper and paper 
guide are misaligned, readjust the paper guides according to the paper size.

% When you load custom size paper, adjust the paper guides according to the paper size.

4 When the paper settings screen appears on the operator panel, press the + or , button to select paper 
size, and press the  button.

% The factory default settings are configured not to display the paper settings screen. To display the 
paper settings screen, for [Bypass Tray], it is necessary to set [Use Driver Setting] to [Off], and [Dis-
play Tray Prompt] to [On]. For details, refer to page 7-6.

5 Press the + or , button to select paper type, and press the  button.
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Printing on Paper Loaded in the Bypass Tray
This description uses the procedure for the Windows PCL driver as an example.

1 Press the  <Menu> button.

2 Press the + or , button, select [Trays], and press the  button.

3 Press the + or , button, select [Bypass Tray], and press the  button.

4 Press the + or , button, select [Use Driver Setting], and press the  button.

5 Press the + or , button, select [On], and press the  button.

6 Load paper into the Bypass Tray.

7 On your computer, open the file that you want to print.

8 From the [File] menu, select [Print].

NOTICE
Menu names may differ depending on the application.

9 From [Select Printer], select this machine, and click on [Preferences].

10 Under the [Paper/Output] tab, click on  for [Paper], then select [Select By Tray] > [Bypass Tray].

11 Click on  for [Paper], then specify the same paper size and type as is loaded in the paper tray.

12 Click on [OK].

13 Click on [Print].

Tips
- Under the print driver's [Select By Tray], you can print by selecting [Automatically Select]. In this case, 

at the [Bypass Tray] screen, set [Use Driver Setting] to [Off], and correctly specify the same paper size 
and type as is loaded.

dReference
For details about a print driver feature, see the print driver help.
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4.4.4 Loading Envelopes
Envelopes can be loaded in the Bypass Tray or Tray 1.

Tips
- If the envelopes are not loaded right after they are unpacked, they may curl. To avoid jams, press the 

envelopes firmly to flatten them before loading, as shown in the illustration.

- If the envelopes do not feed correctly, curl the envelope edges as shown in the illustration. For curl 
width, 0.08 to 0.12" (2 to 3 mm) is recommended. Curl an area extending 0.32 to 0.39" (8 to 10 mm) 
from the edge of the envelopes. Take care not to curl excessively or to cause wrinkles.

Feed direction

0.08 to 0.12" 
(2 to 3 mm)

0.32 to 0.39" 
(8 to 10 mm)
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Envelopes with the Flap on the Short Edge

% Place the side on which you want to print facing up, open the flap, and load so that the bottom edge of 
the envelope enters the machine first.

When the Flap Is on the Long Edge

No. 10 Envelope, Monarch Envelope, DL Envelope, C5 Envelope

% Place the side on which you want to print facing up, close the flap, and load so that the flap faces to-
ward the left side of the machine.
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DL Envelope

% Open the flap, and load the envelope so that its bottom edge enters the machine first.
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5 Printing

5.1 Printing From a Computer

Tips
The content of print driver settings override settings configured through the operator panel. For details about 
a print driver feature, refer to the print driver help.

The following describes a typical printing procedure.

5.1.1 For Windows

1 Open the file that you want to print.

2 From the [File] menu, select [Print].

NOTICE
Menu names may differ depending on the application.

3 From [Select Printer], select this machine, and click on [Preferences].

4 Change the settings as needed, then click on [OK].

5 Click on [Print].

5.1.2 For Mac

Tips
When using the AirPrint feature with a USB connection, log in to Internet Services as the Administrator and 
click on [Network] in the upper part of the screen. From [Mobile Printing], select [AirPrint], then select the 
checkbox for [USB Connection]. For details, refer to page 12-17.

1 Open the file that you want to print.

2 From the [File] menu, select [Print].

NOTICE
Menu names may differ depending on the application.

3 From [Printers], select this machine, and change the settings as necessary.

4 Click [Print].
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5.2 Canceling a Print Job

5.2.1 Canceling a Job From the Operator Panel

% Press the  <Cancel Job> button.

5.2.2 Canceling a Job From a Computer

1 Double-click on the printer icon in the Windows task bar.

2 Select the document to cancel, and press the <Delete> key.

Tips
- If the document to be canceled is not displayed in the window, cancel printing from the operator panel.

- Print jobs can be canceled in the [Jobs] tab of the Internet Services. For details on how to operate, refer 
to page 12-10.

5.3 Printing Color Jobs in Black and White
Forcibly prints color jobs in black and white for all users.

Tips
- You can also use the Print Accounting feature to restrict color printing by user. For details, refer to 

page 8-9.

1 Press the  <Menu> button.

2 Press the + or , button, select [Security Settings], and press the  button.

3 Press the + or , button, select [Print Accounting], and press the  button.

4 Press the + or , button, select [Auto Color To Mono Print], and press the  button.

5 Press the + or , button, select [On], and press the  button.

6 Turn off the machine, and then turn it on again.

7 Perform printing.
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5.4 Using Stored Print (Windows)
Temporarily store the document to be printed in the machine, and begin printing from the operator panel. 
Convenient features include Secure Print, which enables you to assign passcode to documents for confiden-
tial document management, and Sample Set, which enables you to print multiple sets of print jobs.

Tips
The data in the memory is cleared when the machine is turned off.

5.4.1 Secure Print
On the print driver, you can set the user ID and passcode and save printing instruction data in the machine. 
When you want to print, you can then do so by operating the machine.

Specifying With the Print Driver

1 Open the file that you want to print.

2 From the [File] menu, select [Print].

NOTICE
Menu names may differ depending on the application.

3 From [Select Printer], select this machine, and click on [Preferences].

4 Under the [Paper/Output] tab, select [Secure Print] from [Job Type].

5 At [Setup], specify [User ID] and [Secure Print Passcode], then click on [OK].

6 Change the settings as needed, then click on [OK].

7 Click on [Print].

dReference
For details about a print driver feature, see the print driver help.

Printing Secure Print Jobs

1 Press the * button.

2 Press the + or , button, select [Secure Print], and press the  button.

3 Press the + or , button, select the desired user ID, enter the passcode and press the  button.

4 Press the + or , button, select the desired document, and press the  button.

5 Press the + or , button, select [Print and Delete] or [Print and Save], and press the  button.

6 Press the + or , button to specify the number of copies to print, then press the  button.

Send confidential data
Enter the password from
the operator panel Print data
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Deleting Secure Print Jobs

1 Press the * button.

2 Press the + or , button, select [Secure Print], and press the  button.

3 Press the + or , button, select the desired user ID, enter the passcode and press the  button.

4 Press the + or , button, select the desired document, and press the  button.

5 Press the + or , button, select [Delete], and press the  button.

5.4.2 Sample Set
When printing multiple copies of a job, the Sample Set feature enables you to store the print data in the ma-
chine, print one initial copy of the job, then to check the print result before starting to print the rest of the 
copies from the operator panel.

Specifying With the Print Driver

1 Open the file that you want to print.

2 From the [File] menu, select [Print].

NOTICE
Menu names may differ depending on the application.

3 From [Select Printer], select this machine, and click on [Preferences].

4 Under the [Paper/Output] tab, select [Sample Set] from [Job Type].

5 At [Setup], specify [User ID].

6 Change other settings as needed, and click on [OK].

7 Click on [Print].

Tips
- Only one copy will be printed, and the document will be stored in the machine.

dReference
For details about a print driver feature, see the print driver help.

Print a single set

Print the rest of sets
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Printing Sample Set Jobs

1 Press the * button.

2 Press the + or , button, select [Sample Set], and press the  button.

3 Press the + or , button, select the desired user ID, and press the  button.

4 Press the + or , button, select the desired document, and press the  button.

5 Press the + or , button, select [Print and Delete], and press the  button.

6 Press the + or , button to specify the number of copies to print, then press the  button.

Deleting Sample Set Jobs

1 Press the * button.

2 Press the + or , button, select [Sample Set], and press the  button.

3 Press the + or , button, select the desired user ID, and press the  button.

4 Press the + or , button, select the desired document, and press the  button.

5 Press the + or , button, select [Delete], and press the  button.
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5.5 Printing on Envelopes

1 Load envelopes into Tray 1 or the Bypass Tray.

% For details on loading envelopes, refer to page 4-14.

2 Open the file that you want to print.

3 From the [File] menu, select [Print].

4 From [Select Printer], select this machine, and click on [Preferences].

5 On the lower part of the [Paper/Output] tab, click on [Envelope/Paper Setup Wizard].

6 Click on [Envelope] > [Next].

7 Select the envelope size or paper type to be used from [Paper Size] and [Paper Type], then click on 
[Next].

8 Select the tray to be loaded with the envelopes used from [Paper Tray], then click on [Finish].

9 Configure the other print settings as needed.

10 Click on [OK].

11 Click on [Print] to begin printing.
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6 Printing From Smartphones or Tablets

6.1 Connecting the Machine to Smartphones/Tablets
You can connect a smartphone, tablet or other mobile device for easy, quick printing or scanning of docu-
ments, photos, etc.

Use any of the following methods to connect the machine to a mobile device.

- Via Wireless Network
Connect the machine and the mobile device using an access point or wireless router.

- Via Wi-Fi Direct
Connect the machine and the mobile device directly without using an access point or wireless router.

6.1.1 Via Wireless Network

Setting Up the Machine

% Make sure that the machine is connected to the wireless network.

% For details on connection methods, refer to page 3-7.

Setting Up the Mobile Devices

Tips
The procedure varies depending on the model of the mobile device. For details, see the manual supplied with 
the mobile device.

1 Enable the Wi-Fi function of the mobile device.

2 Select the network (SSID) that the machine is connected to.

3 Enter the passphrase, and then establish the wireless connection.

% A passphrase may be printed on the exterior of an access point or wireless router. For details, see 
the manual supplied with the access point or wireless router.
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6.1.2 Via Wi-Fi Direct

Tips
You can connect up to three mobile devices.

Setting Up Wi-Fi Direct
To use Wi-Fi Direct, you need to first configure the Wi-Fi Direct settings from the operator panel of the ma-
chine. When you select the SSID of the machine on the display of the mobile device and then enter the spec-
ified passphrase, the mobile device will be connected to the machine via Wi-Fi Direct.

Setting Up the Machine

Tips
- You can also use Internet Services to configure the settings. For details, refer to page 12-16.

- Wi-Fi Direct cannot be used in an IPv6 or Ad-hoc environment.

1 Press the  <Menu> button.

2 Press the + or , button, select [Network Settings], and press the  button.

3 Press the + or , button, select [Wi-Fi Direct], and press the  button.

4 Select [Wi-Fi Direct], and press the  button.

5 Press the + or , button, select [Enable], and press the  button.

6 Turn off the machine, and then turn it on again.

7 After restarting the machine, perform steps 1 - 3.

8 Press the + or , button, select [Paired Device], and press the  button.

9 Confirm that no more than two mobile devices are displayed on the screen, and press the  <Back> 
button.

% If there are three mobile devices connected, additional connections to the Wi-Fi Direct network will 
not be possible. Disconnect all currently connected mobile devices from the network. For details, 
refer to page 6-5.

10 Press the + or , button, select [SSID], and press the  button.

11 Change SSID as needed, and press the  button.

When the SSID is changed, the mobile devices shown on the screen in step 8 are disconnected.

12 Press the  <Back> button.

13 Press the + or , button, select [Passphrase], and press the  button.

14 Confirm the passphrase and press the  <Back> button.

Tips
Press the  or ) button, then under the [Passphrase] menu, select [Print passphrase], and press the  
button. You can then print a sheet showing the SSID and passphrase for the machine.
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Connecting Mobile Devices to the Machine

dReference
For details, see the manual supplied with the mobile device.

1 Enable the wireless LAN function of the mobile device.

2 Select the SSID of the machine.

3 Enter the passphrase and press the  button to establish the connection.

Disconnecting the Mobile Device From the Wi-Fi Direct Network

1 Press the  <Menu> button.

2 Press the + or , button, select [Paired Device], and press the  button.

When a mobile device is connected to the machine through Wi-Fi Direct, [Paired Device] will appear.

3 When the name of the currently connected mobile device is displayed, press the button.

4 Press the + or , button, select [Disconnect All], and press the  button.

5 When an execution confirmation message appears, press the  button.

Resetting the Passphrase

Tips
Resetting the passphrase will disconnect the mobile device.

1 Press the  <Menu> button.

2 Press the + or , button, select [Paired Device], and press the  button.

When a mobile device is connected to the machine through Wi-Fi Direct, [Paired Device] will appear.

3 Press the + or , button, select the mobile device for which you will initialize the passphrase, and press 
the  button.

4 Press the + or , button, select [Reset passphrase], and press the  button.

5 When an execution confirmation message appears, press the  button.

Mobile devices are disconnected, and the new passphrase is displayed.

6.2 Printing Using the Mobile Print
Mobile Print is an application for use with smartphones or tablets. You can print from smartphones or tablets. 
When using a device with the NFC feature, you can start printing simply by holding the device over the NFC 
touch area. You can download it from the App Store or Google Play.
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6.3 Using Other Print Services

6.3.1 AirPrint
AirPrint is a printing service offered by Apple Inc. Without installing the print drivers or special programs, you 
can print the documents specified on iOS devices such as iPad or iPhone, or on Mac.

Tips
When using this feature with [Print Accounting] enabled, it is necessary to enable [Unauthenticated User 
Print]. For details, refer to page 7-14.

Enabling the AirPrint Settings

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [Network] in the upper part of the screen.

5 Click on [Mobile Printing] > [AirPrint].

6 Select the checkbox for [Enable].

% When connected via USB, select the [USB Connection] check box for [AirPrint].

7 Click on [OK].

8 Click on [Restart Now].

9 Once the machine completes restart, click on [Refresh].
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Printing With AirPrint
The following procedure uses iOS as an example.

1 Open your e-mail, photo, web page, or document that you want to print.

2 Tap the action icon.

3 Tap [Print].

4 Select the machine and set machine options.

5 Tap [Print].

6.3.2 Mopria Print Service
Mopria Print is a service that enables you to print from printers certified by Mopria via Android (5.0 and later) 
smartphones and tablets without any special settings.

Start by downloading the Mopria Print Service app to your Android device from the Google Play Store and 
installing it.

In order to print, connect your mobile device to the same network as the machine or use the Wi-Fi Direct func-
tionality to connect your mobile device to the machine.

Tips
When using this feature with [Print Accounting] enabled, it is necessary to enable [Unauthenticated User 
Print]. For details, refer to page 7-14.
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Setting Up Mopria Print Service on the Machine

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [Network] in the upper part of the screen.

5 Click on [Mobile Printing] > [Mopria].

6 Click on [Enable] > [OK].

Printing With Mopria Print Service

% For details, see https://mopria.org/. 
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7 Changing the Machine Settings

7.1 Understanding the Machine Settings Menus
The following describes the settings that appear when the  <Menu> button in the operator panel is 
pressed.

7.2 [Language]
You can specify the display language.

7.3 [About]
Display the machine's software version.

7.4 [Information Pages]
You can print the following reports and lists.

7.4.1 [Printer Settings]
Print a list of information on machine settings and configuration, such as network settings and installed op-
tional accessories.

7.4.2 [Panel Settings]
Print the details of the machine's settings.

7.4.3 [PCL Font List]
Print a list of the Printer Control Language (PCL) fonts that can be used with the machine.

Setting Description

[Language] You can select the language used on the machine.

[About] Display the machine's software version.

[Information Pages] You can print various reports and lists.

[Trays] You can specify the size and type of paper loaded in Tray 1, the Bypass 
Tray, and Tray 2 (Paper Feed Unit PF-P26) (optional).

[Billing Counters] You can check the total number of pages printed up to now.

[General] You can configure the general settings for the machine, such as date, 
time, or sound.

[Network Settings] You can configure the network settings.

[Security Settings] You can configure the security settings, such as limiting access to the 
settings menus or functions.

[Maintenance] You can configure the maintenance settings, such as for cleaning the 
transfer unit and initializing the memory.

[Advanced Settings] You can customize the settings in accordance with the setting environ-
ment, or your preferences.
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7.4.4 [PCL Macro List]
Print information on the downloaded PCL macro.

7.4.5 [PS Font List]
Print a list of the PostScript language compatibility fonts that can be used with the machine.

7.4.6 [PDF Font List]
Prints a sample of the available PDF fonts.

7.4.7 [Job History]
Print a history of print jobs that have been executed by the machine. This list contains the latest 20 jobs.

7.4.8 [Error History]
Print a detailed list of paper jams and fatal errors.

7.4.9 [Printer Counter]
Print a report on the total number of pages printed.

7.4.10 [Demo Page]
Prints a sample stored in the machine.

7.4.11 [Stored Document List]
Print a list of print jobs saved using the Sample Set feature.

7.4.12 [Supplies Status]
Print the status of consumables usage.



bizhub C3100i 7-5

7.5 [Trays] 7

7.5 [Trays]
Specify the size and type of paper loaded in Tray 1, the Bypass Tray, and Tray 2 (Paper Feed Unit PF-P26) 
(optional).

- [Tray 1] (page 7-5)

- [Tray 2] (page 7-5)

- [Bypass Tray] (page 7-6)

- [Tray Priority] (page 7-6)

dReference
For sizes and types of print media that can be used, refer to page 4-6.

7.5.1 [Tray 1]
Specify the size or type of paper loaded in Tray 1.

[Paper Size]
Select the paper size.

[Paper Type]
Select the paper type.

[Display Tray Prompt]
Specify whether to display a screen for specifying the paper size and paper type when paper is loaded in 
Tray 1.

7.5.2 [Tray 2]

Tips
- When Tray 2 (Paper Feed Unit PF-P26) (optional) is installed, it can be used.

Specify the size and type of paper loaded in Tray 2 (Paper Feed Unit PF-P26) (optional).

[Paper Size]
Select the paper size.

[Paper Type]
Select the paper type.

[Display Tray Prompt]
Specify whether to display a screen for specifying the paper size and paper type when paper is loaded in Tray 
2 (Paper Feed Unit PF-P26) (optional).
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7.5.3 [Bypass Tray]
Specify the size and type of paper loaded in the Bypass Tray.

[Use Driver Setting]
Specify whether to use the paper size and type specified on the print driver.

Tips
- When specifying the paper size and paper type from the machine, select [Off].

[Paper Size]
Select the paper size.

When using nonstandard paper sizes, select [Custom], and specify the paper length and width on the [Cus-
tom Paper Size] screen that appears.

Tips
- For paper that can be used, refer to page 4-6.

[Paper Type]
Select the paper type.

[Display Tray Prompt]
Specify whether to display a screen for defining the paper size and type when paper is loaded in the Bypass 
Tray.

7.5.4 [Tray Priority]
Specify an order of priority in which the paper trays are to be used. If two or more paper trays are loaded with 
the same paper size and type, the paper tray to be used is automatically selected according to this priority 
order.
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7.6 [Billing Counters]
You can check the total number of pages printed up to now.

[Counter 1]
Displays the total number of color printouts.

[Counter 2]
Displays the total number of monochrome printouts.

[Counter 3]
Always shows "0" on your printer.

[Counter 4]
Displays the total number of color and monochrome prints ([Counter 1]+ [Counter 2]).

7.7 [General]
You can configure the general settings for the machine, such as date, time, or sound.

- [Date & Time] (page 7-7)

- [Sounds] (page 7-7)

- [NFC] (page 7-7)

- [Status LED(Green)] (page 7-7)

- [Power Saver] (page 7-8)

- [Timers] (page 7-8)

- [Units] (page 7-8)

- [Default Paper Size] (page 7-8)

7.7.1 [Date & Time]
Set the date, time, and time zone.

7.7.2 [Sounds]
Select the volume level of the notification sounds.

7.7.3 [NFC]
Specify whether to allow a mobile device such as a tablet or a smartphone to connect to the machine via NFC 
communication.

7.7.4 [Status LED(Green)]
Specify whether to enable the blinking feature of the Status LED on the operator panel.

dReference
For details on status LEDs, refer to page 2-8.
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7.7.5 [Power Saver]
Set the amount of time until the machine enters the power saver mode.

dReference
For details on power saving features, refer to page 4-5.

7.7.6 [Timers]
Configure the timer settings.

[Auto Clear]
Specify the amount of time until the display returns to the default screen when the machine is not operated 
for a certain period of time.

[Fault Timeout]
Specify the amount of time until the display returns from the error screen to the Print screen when an error 
occurs which does not require user operation to clear.

7.7.7 [Units]
Select the default measurement unit of the numeric value displayed on the operator panel.

7.7.8 [Default Paper Size]
Select from Letter or A4 for paper size used in printing reports or data of unspecified size.
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7.8 [Network Settings]
You can configure the network settings.

- [Network] (page 7-9)

- [Wi-Fi] (page 7-9)

- [Wi-Fi Direct] (page 7-10)

- [Ethernet] (page 7-11)

- [Protocol] (page 7-12)

- [Other] (page 7-12)

7.8.1 [Network]
You can switch between wireless LAN (Wi-Fi) and wired LAN (Ethernet) network connections.

7.8.2 [Wi-Fi]

Tips
- This setting can be used when [Wi-Fi] is selected in [Network].

Configure the wireless network settings.

[Wi-Fi Status]
Display the status of wireless network connections.

[Wi-Fi Setup]
To configure the wireless network settings, either select the wireless network access point from those on the 
screen display, or select either [Enter (SSID)] or [WPS].

Setting Description

[Select access] Select the wireless network access point for the 
connection.

[WEP Key] When the wireless network access point encryp-
tion type is WEP, enter the WEP key.

[Passphrase Entry] When the wireless network access point encryp-
tion type is WPA, WPA2 or Mixed, enter the 
passphrase.

[Manual Setup] Manually configure wireless network settings.

[Enter SSID] Enter the name to identify the wireless LAN ac-
cess point.

[Infrastructure] Select the encryption type for an infrastructure 
network.

[Ad hoc] Specify the encryption type for Ad-hoc mode.

Note
[Ad hoc] settings can be used when [Wi-Fi Direct] 
is disabled.
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[WPS Setup]
Specify the wireless network settings using WPS.

[IP Mode]
Select the IP mode.

Tips
- When [IPv6] Mode is set, Wi-Fi Direct cannot be used.

[TCP/IP]
Configure the TCP/IP settings.

[Reset Wi-Fi]
Initializes wireless network settings. After performing this setting and restarting the machine, all the wireless 
network settings are reset to their factory settings.

7.8.3 [Wi-Fi Direct]

Tips
- This setting can be used when [Wi-Fi] is selected in [Network].

- Wi-Fi Direct cannot be used in an IPv6 or Ad-hoc environment.

Configure the Wi-Fi Direct network settings.

[Wi-Fi Direct]
Specify whether to enable or disable the Wi-Fi Direct network.

Setting Description

[Push Button] Configure the wireless network settings using WPS (pushbutton 
method).

[PIN Code] Configure the wireless network settings using a PIN code assigned 
to the machine.

Setting Description

[Dual Stack] Uses both IPv4 and IPv6 to specify the IP address.

[IPv4] Uses IPv4 to specify the IP address.

[IPv6] Uses IPv6 to specify the IP address.

Setting Description

[IP Addressing] Specify the method for acquiring an IP address.

[IP Address] Display the IP address assigned to this machine. With [IP Address-
ing] set to [Manual Input], enter the IP address.

[Subnet Mask] Display the subnet mask assigned to this machine. With [IP Address-
ing] set to [Manual Input], enter the subnet mask.

[Gateway Address] Display the gateway address assigned to this machine. With [IP Ad-
dressing] set to [Manual Input], enter the gateway address.
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[Group Role]

[Device Name]
Enter the machine name that identifies the Wi-Fi Direct network with up to 32 alphanumeric characters.

When you select the machine name on your mobile device, find the name specified here.

[Paired Device]
Displays the status of the Wi-Fi Direct connections.

[SSID]
Displays the name of the network to be identified by Wi-Fi Direct. It can be entered following "DIRECT-XX" 
using no more than 23 alphanumeric characters. When selecting the name of the network connection through 
a mobile device, the specified name will be displayed here.

[Passphrase]
Displays the passphrase. Enter the passphrase displayed here when you connect to the Wi-Fi Direct network 
from your mobile device.

7.8.4 [Ethernet]

Tips
- This setting can be used when [Ethernet] is selected in [Network].

Configure the wired network settings.

[IP Mode]
Select the IP mode.

Setting Description

[Group Owner] Sets the machine as the group owner of the Wi-Fi Direct network. 
When the machine is set to the group owner, the machine functions 
as the access point or wireless router.

[Auto] Automatically specifies the group role of the machine.

Setting Description

[Disconnect All] Disconnects all the Wi-Fi Direct connections.

[Reset Passphrase] Disconnects the Wi-Fi Direct connections and changes the 
passphrase.

Setting Description

[Print Passphrase] Print the passphrase.

[Reset Passphrase] Disconnects the Wi-Fi Direct connections and changes the 
passphrase.

Setting Description

[Dual Stack] Uses both IPv4 and IPv6 to specify the IP address.

[IPv4] Uses IPv4 to specify the IP address.

[IPv6] Uses IPv6 to specify the IP address.
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[TCP/IP]
Configure the TCP/IP settings.

[Modem Speed]
Select the communication speed and the duplex settings of Ethernet.

7.8.5 [Protocol]
Specify whether to enable or disable each protocol.

7.8.6 [Other]
Configure the advanced network settings.

[IPv4 - Filter]
Specifies whether to restrict devices that can communicate with the machine. Range of IPv4 address to allow 
communication with the machine can be set in Internet Services.

Tips
- This feature does not apply to communication via Wi-Fi Direct.

[IPv6 - Filter]
Specifies whether to restrict devices that can communicate with the machine. Range of IPv6 address to allow 
communication with the machine can be set in Internet Services.

Tips
- This feature does not apply to communication via Wi-Fi Direct.

[PS Data Format]
Specifies the PostScript language compatibility communication protocol.

Setting Description

[IP Addressing] Specify the method for acquiring an IP address.

[IP Address] Display the IP address assigned to this machine. With [IP Address-
ing] set to [Manual Input], enter the IP address.

[Subnet Mask] Display the subnet mask assigned to this machine. With [IP Address-
ing] set to [Manual Input], enter the subnet mask.

[Gateway Address] Display the gateway address assigned to this machine. With [IP Ad-
dressing] set to [Manual Input], enter the gateway address.

Setting Description

[Auto] Used when auto-detecting the PostScript language compatibility 
communication protocol.

[Normal] Used when the communication protocol is in ASCII interface.

[BCP] Used when the communication protocol is in binary format.

[TBCP] Used when the communication protocol supports both ASCII and bi-
nary data to switch between them according to the specified control 
code.

[Binary] Used when no special processing is required for data.
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[IEEE 802.1x]
Disable IEEE 802.1x authentication.

Tips
- This setting can be used when the machine is connected using a LAN cable, and IEEE 802.1x authen-

tication has been specified through Internet Services. For details, refer to page 12-14.

[Reset Network Settings]
Initialize the wired LAN (Ethernet) and wireless LAN (Wi-Fi) settings stored in memory. After performing this 
setting and restarting the machine, all the Ethernet and wireless network settings are reset to their factory 
settings.

[Delete All Certificates]
Deletes all certificates of the machine.

7.9 [Security Settings]
You can configure the security settings, such as limiting access to the setting menus or functions.

- [Admin Authentication] (page 7-13)

- [Print Accounting] (page 7-14)

- [Software Download] (page 7-14)

- [Login Attempts] (page 7-14)

- [Security Warning] (page 7-14)

- [Svc Rep. Op. Restriction] (page 7-14)

- [Restrict Job Display Info] (page 7-15)

- [Restriction for Print Jobs] (page 7-15)

7.9.1 [Admin Authentication]
Specify whether to use the Admin Authentication feature to impose restrictions on access to each feature by 
setting passcodes.

Access restrictions can be applied to the following features:

- [Information Pages]

- [General]

- [Network Settings]

- [Security Settings]

- [Maintenance]

- [Advanced Settings]

dReference
For details, refer to page 4-4.

[Change Passcode]
Change the passcode to be used.
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7.9.2 [Print Accounting]
Configure the print restriction settings.

[Print Accounting]
Restricts printing and counts up printed pages for each user.

Tips
- For details on how to limit user registration and printing with this machine, refer to page 8-10 and 

page 8-12.

[Unauthenticated User Print]
Enable [Print Accounting], and jobs for which account information (user name and password) is missing can-
not be printed. Enable this feature when printing of jobs without account information is to be permitted. The 
jobs without account information are the following:

- Jobs generated using other company's print drivers or utilities

- Jobs submitted using the following features:

- USB Direct Print
- AirPrint
- Mopria Print Service

Tips
- Even if a print driver or an application provided by us is used, jobs generated with the print driver's or 

application's user authentication settings disabled are regarded as jobs without account information.

[Auto Color To Mono Print]
When [Print Accounting] is enabled

The system forces monochrome printing of color jobs of users subject to restrictions on color printing. When 
[Unauthenticated User Print] is enabled, the system forces monochrome printing of color jobs without ac-
count information.

Tips
- Users restricted from printing in color are users prohibited to use color printing in [Accounting] of the 

Internet Services. If [Auto Color To Mono Print] is disabled, color print jobs of users restricted from print-
ing in color will be canceled. For details, refer to page 8-12.

When [Print Accounting] is disabled

Forcibly prints color jobs in black and white for all users.

7.9.3 [Software Download]
Specify whether to enable download of firmware updates.

7.9.4 [Login Attempts]
Specify whether to limit the number of Admin Authentication logins, and the number of login attempts if a 
limit is to be imposed.

7.9.5 [Security Warning]
Specify whether a security warning will appear when a user identified as the administrator accesses Internet 
Services for a device that has been assigned a global IP address.

7.9.6 [Svc Rep. Op. Restriction]
You can restrict Customer Engineer operations so that a Customer Engineer cannot alter the settings of the 
machine.
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7.9.7 [Restrict Job Display Info]
Specify whether to display or hide personal information of the jobs. Items that can be hidden are document 
title and user name of the job information that are displayed on the Internet Services.

7.9.8 [Restriction for Print Jobs]
Specify whether to limit the number of jobs that can be printed on this machine to Secure Print only.

7.10 [Maintenance]
You can configure the maintenance settings, such as for cleaning the transfer unit and initializing the memory.

- [Adjust Paper Type] (page 7-15)

- [Adjust Transfer Belt Unit] (page 7-15)

- [Adjust 2nd BTR] (page 7-15)

- [Image Position] (page 7-15)

- [Adjust Fusing Unit] (page 7-16)

- [Adjust Image Quality] (page 7-16)

- [Clean Marking Units] (page 7-16)

- [Toner Refresh] (page 7-16)

- [Bypass Tray Feed Method] (page 7-16)

- [Initialize NVM] (page 7-17)

- [Initialize Print Counter] (page 7-17)

- [Clear Stored Jobs] (page 7-17)

- [Clear Forms] (page 7-17)

- [Toner Cartridge] (page 7-17)

- [Adjust Altitude] (page 7-17)

- [Clear Job History] (page 7-17)

7.10.1 [Adjust Paper Type]
Select the paper type.

7.10.2 [Adjust Transfer Belt Unit]
If ghosting occurs with output text and images, adjust the transfer voltage. If faint ghosting occurs, decrease 
the value to decrease the voltage.

7.10.3 [Adjust 2nd BTR]
For each paper type, adjust the transfer voltage of the transfer roll (BTR). If the colors on the print results are 
mottled, increase the value to increase the voltage. If there are blank white areas or uneven density near the 
bottom of the paper, decrease the value to decrease the voltage.

7.10.4 [Image Position]
If the print position is misaligned, adjust the image position.

[Lead/Side Registration]
For each tray, misalignment of the image position for either feed direction (lead [L] or side [S] registration) can 
be adjusted numerically.

[Perpendicularity]
Image perpendicularity can be adjusted numerically.
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[Print Chart]
Print a position adjustment chart. This enables you to check for any misalignment in image position.

7.10.5 [Adjust Fusing Unit]
Adjust the temperature of the fusing unit for each paper type. If the paper curls, lower the temperature. If the 
toner does not properly adhere to the paper, raise the temperature.

7.10.6 [Adjust Image Quality]
Configure image quality and color correction settings.

[Adjust Color Registration]
If color registration is misaligned in print output, adjust color registration (color registration misalignment) ei-
ther automatically or manually. Print a chart to perform manual adjustment.

[Adjust Density]
Correct toner density. Changing the numerical value changes the thickness and thinness.

[PrintHeadDensity(1Stripe)]
This can be used when streaks (lines) appear in print output. Print a chart to make adjustments.

[PrintHeadDensity(Stripes)]
This can be used when regularly patterned streaks (vertical lines) appear in output. Print a chart to make ad-
justments.

[Image Quality for Coated]
Specify image quality when printing on coated paper.

7.10.7 [Clean Marking Units]
Clean the developer and transfer unit. Perform when the output result is blurred.

Tips
- This feature uses drum cartridge, and may therefore shorten the service life of the drum cartridge.

7.10.8 [Toner Refresh]
Corrects toner and developer balance. Perform when the output result is blurred.

Tips
- This feature uses toner, and may therefore shorten the service life of the toner cartridge, drum cartridge 

and waste toner box.

7.10.9 [Bypass Tray Feed Method]
Paper feed error of the machine will be reduced by selecting [Reduce Covers Feed Error] when using thick 
paper, envelope, label, or coated paper in the Bypass Tray.
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7.10.10 [Initialize NVM]
Initialize memory (NVM). After performing this setting and restarting the machine, all the machine settings are 
reset to their factory default values.

[User App Settings]
Deletes the added widget applications.

[System Settings]
Resets the system settings to the factory default state.

7.10.11 [Initialize Print Counter]
Resets the print counter.

7.10.12 [Clear Stored Jobs]
Clears print jobs saved using the stored print feature.

7.10.13 [Clear Forms]
Delete forms stored in the machine.

7.10.14 [Toner Cartridge]
Specify the toner cartridge to be used.

[Non-Genuine Toner]
Enable this function when you need to continue using the product even when the time has come to replace 
the toner cartridge.

NOTICE
Once Non-Genuine Toner mode is enabled, it cannot be disabled.

Quality is not guaranteed when using this mode. Therefore, the designated functions and performance may 
not be achieved with this mode. Continuing using the product in this state may cause a printer malfunction.

In Non-Genuine Toner Mode, the settings (page 7-22) will be ignored. Also, toner and drum cartridge remain-
ing content levels will not be displayed.

7.10.15 [Adjust Altitude]
If the machine is installed in a location with a high elevation, specify the altitude.

When the altitude is correctly selected, optimum printing quality is attained, and the remaining amount of ton-
er is correctly displayed.

7.10.16 [Clear Job History]
Clears the job history of all finished jobs.
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7.11 [Advanced Settings]
You can customize the settings in accordance with the setting environment, or your preferences.

- [PS Settings] (page 7-18)

- [PCL Settings] (page 7-18)

- [PDF Settings] (page 7-20)

- [USB Port Settings] (page 7-20)

- [Output Settings] (page 7-21)

- [Low Toner Alert Message] (page 7-22)

- [End of Drum Life] (page 7-22)

- [Job History] (page 7-22)

7.11.1 [PS Settings]
Configure PostScript language compatibility-related settings.

[PS Error Report]
Specifies whether to print the contents of the errors concerning PostScript language compatibility page de-
scription language. The change becomes effective after the printer is restarted.

Tips
- Instructions from the PostScript language compatibility driver override the settings specified on the op-

erator panel.

[PS Job Timeout]
Specifies whether to specify the execution time for one PostScript language compatibility job. The change 
becomes effective after the printer is restarted.

[Paper Trays]
Specifies the way to select the tray for PostScript language compatibility mode. The change becomes effec-
tive after the printer is restarted.

[PS Default Color]
Select the default color mode for PostScript language compatibility mode.

7.11.2 [PCL Settings]
Configure the machine settings related to the Printer Control Language (PCL).

[Paper Trays]
Specify the paper tray to be used.

[Output Size]
Specify the print paper size.

[Original Orientation]
Specify how text and graphics are oriented on a page.

[2-Sided]
Specify whether to print on both sides of a sheet of paper. For two-sided printing, specify whether the print-
outs are bound at the long edge or short edge.
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[Font]
Specify the default font.

[Symbol Set]
Specify the default symbol set.

[Font Size]
Specify the font size for scalable typographic fonts.

[Font Pitch]
Specify the font pitch for scalable mono spaced fonts. Font pitch refers to the number of characters printed 
in one horizontal inch.

[Form Line]
Specify the number of prints to be made of each page. Line spacing is configured based on [Output Size] and 
[Original Orientation]. Specify paper size and document orientation in advance.

[Quantity]
Specify the number of copies to print.

Tips
- For a specific job, set the quantity from the print driver. Values selected from the print driver always 

override values selected from the operator panel.

[Image Enhance]
Specify whether to enable the image enhance feature. Enabling this feature makes the boundary line between 
black and white smoother to decrease jagged edges and enhance the visual appearance.

[Hex Dump]
All data sent to the machine is printed in hexadecimal and representation, facilitating troubleshooting analy-
sis. Control codes are not executed.

[Draft Mode]
Specify whether to save toner when printing. The print quality is lower when compared to normal printing.

[Line Termination]
Specify whether to add line termination commands.

[Output Color]
Select the color mode.

[Ignore Form Feed]
Specify whether not to print the blank pages without any images, and to print only the pages with images.
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7.11.3 [PDF Settings]
Configure the machine settings that only affect PDF files.

[Quantity]
Specify the number of copies to print.

[2-Sided]
Specify whether to print on both sides of a sheet of paper. For two-sided printing, specify whether the print-
outs are bound at the long edge or short edge.

[Print Mode]
Select the print mode.

[PDF Password]
Set the password used to print PDF files protected by a password.

[Collation]
Configure the default setting to specify whether to produce output page by page or grouped by batch when 
printing multiple pages multiple times.

[Output Size]
Specify the print paper size.

[Layout]
Specify a print layout.

[PDF Default Color]
Select the color mode.

[Detect Job Separator]
Specify whether to detect that a print job has been completed successfully.

7.11.4 [USB Port Settings]
Configure the machine USB port settings.

[Port Status]
Specify whether to enable the machine's USB port.

[Fixed Port]
Specify whether to use the same port as the one specified when the software has been installed.

[PS Data Format]
Specify the PostScript language compatibility transmission protocol.

[Job Timeout]
Set the amount of time the machine waits until the machine receives data from the computer. The print job 
is canceled when the job is not printed within the specified time frame.
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7.11.5 [Output Settings]
Configure the settings for printing from the machine.

[Print ID]
Specify whether to print the user ID, and select the location where the ID is printed.

[Print Text]
Specify whether to print Page Description Language (PDL) data as text when the data is not supported by 
the machine.

[Substitute Tray]
Specify whether to use paper of a different size when the paper that is loaded in the specified tray does not 
match the paper size settings for the current job.

[A4/Letter Switch]
Specify whether to print A4 size jobs on Letter size paper if A4 size paper is not available, or to print Letter 
size jobs on A4 size paper if Letter size paper is not available.

[Prioritize Bypass Tray]
Specify whether to use the bypass tray when the paper tray is automatically selected from the print driver.

When [On] is specified, the paper tray is automatically selected from the printer driver, and the Bypass Tray 
is loaded with paper, the Bypass Tray will be used.

[Show Size Mismatch Error]
Specify whether an error is to be indicated on the operator panel in cases where the paper size specified in 
the print driver matches that on the operator panel, but the paper size specified in the print driver is different 
from that loaded in the specified tray.

Tips
- When [Off] is selected, there is a possibility that the following may occur with all trays.

- When the paper size is smaller than the document size, the back side of the paper may become soiled.
- Printing may take some time.
- Misalignment may occur with two-sided printing.

- With Tray 1, the following may occur.
- Paper jams may occur when using paper sizes A5, B6 or smaller.
- Paper may remain inside the machine after printing.
- Paper jams may occur when using paper sizes smaller than A5 for two-sided printing.

- With Tray 2 (Paper Feed Unit PF-P26) (optional), the following may occur.
- Paper jams may occur when using paper size A5 or smaller.
- Paper may remain inside the machine after printing.

- With the Bypass Tray, the following may occur.
- Paper jams may occur when using paper size A5 or smaller for two-sided printing.

[Banner Sheet]
Specify banner sheet insertion position and the tray from which to print.

[Report 2-Sided Print]
Specify whether to print reports on both sides of a sheet of paper.

[Letterhead 2-Sided Print]
Specify whether to print on both sides of letterhead.
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[Hex Dump]
All data sent to the machine is printed in hexadecimal and representation, facilitating troubleshooting analy-
sis. Control codes are not executed.

7.11.6 [Low Toner Alert Message]
Specify whether to show the alert message when toner is low.

7.11.7 [End of Drum Life]
Specify whether to stop printing when a drum cartridge reaches the end of its service life.

Tips
- Make sure that this menu should be specified before the message is displayed to notify you to replace 

the drum cartridge. This setting cannot be changed after the message of the drum cartridge replace-
ment is displayed.

[Cancel Printing]
Stops printing when a drum cartridge reaches the end of its life.

[Continue Printing]
Does not stop printing even when a drum cartridge reaches the end of its life.

Tips
- When the [Order Drum Cartridge] message appears, print image quality is not guaranteed, and it is 

therefore recommended that the drum cartridge be replaced with a new one.

- When the [Replace Drum Cartridge now.] message appears, printing is not possible until the drum car-
tridge is replaced with a new one.

7.11.8 [Job History]
Specify whether to print a Job History report automatically.

If automated, a printout will be generated for every 20 jobs processed.

Tips
- Reports can also be printed from the [Information Pages] menu.
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8 Making Better Use of Your Machine

8.1 Using Internet Services
Internet Services is a service to display status of the machine and job history as well as change settings of 
the machine using a web browser.

In TCP/IP environments, you can use a computer connected to the machine via network.

Main functions that can use Internet Services are as the following.

*1: When Internet Services [Administrator Mode] is enabled and you log in as the administrator, the menu will 
be displayed. For details on how to log in as the administrator, refer to page 8-4.
*2: Displayed when the Print Accounting feature is enabled.

dReference
For details on settings that can be configured from Internet Services, refer to page 12-3.

Menu name Features

[Home] You can check the status of the paper tray and consumables, support 
information, and notifications.

[Jobs] You can check the job list or job history.

[Network]*1 You can configure the settings necessary for network communication.

[Accounting]*2 You can tabulate print volumes and restrict use for each user.

[System]*1 You can configure the settings for security and administrator.
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8.1.1 Starting Internet Services

1 Turn on the computer and open a Web browser.

2 Enter the machine's IP address or URL in the Web browser address entry field, and press the <Enter> 
key.

Top page of the of Internet Services will be displayed.

Tips
- If you are specifying the port number, type ":" after the address, followed by "80" (the factory default 

port number). You can check the port number at [Configuration Report].

- To check the machine's IP address, press the  <Menu> button on the operator panel, + or the , 
button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

8.1.2 Logging in

1 Start Internet Services.

2 Click on [Log In] in the upper right part of the screen.

3 Enter [User Name] and [Password], then click on [Log In].

Tips
- The default user name is set to "admin" with the serial number set as the password.

"Serial Number" can be checked from [About] > [Details] of Internet Services.

- To revoke authentication, click on [Log Out] for the authenticated user name in the upper right part of 
the screen.

8.1.3 About Internet Services Help
Internet Services Help is included in this guide.

For details on settings that can be configured from Internet Services, refer to page 12-3.
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8.2 Using Software Supplied With the Machine
Download [Printer Software] software for the machine and install it in your computer.

8.2.1 Print & Scan Hub (Windows)
The [Print & Scan Hub] software provides the following key features:

- Checking the Status of the Machine/Jobs/Consumables (page 8-6)

- Notification of Printing Completion/Error (page 8-8)
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Checking the Status of the Machine/Jobs/Consumables

Tips
- This feature is available only when the machine is connected to a network.

You can check whether the machine has generated an error, and job status. By starting Internet Services from 
[Print & Scan Hub], you can also check the status of the toner cartridges, drum cartridge, and waste toner 
box, as well as paper tray loads.

1 Click on [Start] > [XXXX Print & Scan Hub] > [Print & Scan Hub].

2 From [Device List], select this machine, and click on [Device Management].

3 Check the status of the machine and jobs.
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4 To check the status of consumables, click on [Device Information].

Internet Services will start and you can check the status of consumables.
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Notification of Printing Completion/Error

Tips
- This feature is available when the machine is connected to Wi-Fi or Ethernet.

When printing is completed or when an error occurs, a notification is displayed on the task bar of the com-
puter screen.

To use this feature, perform the following procedure to enable auto refresh.

1 Click on [Start] > [XXXX Print & Scan Hub] > [Print & Scan Hub].

2 Click on  in the upper right part of the screen, and click on [Device Monitor Settings].

3 Select the checkbox for Auto Check.

4 Configure the [Check Interval (1-60 Minutes)] settings as needed, and click on [OK].

8.2.2 Updating Software
To install the latest software versions, access the Konica Minolta web site in your region, or contact your sup-
plier.
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8.3 Using Print Accounting

8.3.1 Overview
When the Print Accounting feature is enabled, only users registered in the machine (registered users) can 
print. This feature can also restrict each user's printing and count up printed pages. To print, the registered 
user needs to use a print driver or an application provided by us on which the user account information is 
specified.

Tips
- You can register up to 50 users.

The following illustration shows how the machine works with Print Accounting.

Print Accounting has the following features:

- Permitting Only Registered Users to Print (page 8-10)

- Setting Printing Restrictions on Each Registered User (page 8-12)

- Permitting Printing Only in Black and White (page 8-12)
- Limiting the Number of Pages Printable in Color/Black and White (page 8-14)

- Permitting Print Jobs Without Account Information (page 8-16)

- Permitting Printing in Color/Black and White (page 8-16)
- Permitting Printing Only in Black and White (page 8-16)

Setting restrictions on each user

Account information Printing restrictions

User name Password
Color print

Permitted
Prohibited

Color print limit
(pages)

Black and white
print limit (pages)

Account information

User name Password

User registered in the machine

User not registered in the machine

Sending a print job with account information

Printing the job

Printing prohibited

User authentication
Counting up the 
number of printed
pages

Printing a report to check
the printing usage
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8.3.2 Permitting Only Registered Users to Print
To use this feature, settings in the printer driver/application, operator panel and Internet Services are re-
quired.

Configuring Authentication Settings on the Print Driver/Application
Specify account information (user name and password) that is required for authentication when printing from 
a print driver or an application provided by us.

This section describes the procedure using the PCL driver as an example.

1 Click on [Start] > [Windows System] > [Control Panel] > [View devices and printers] or [Devices and 
Printers].

2 Right-click on the machine icon, and select [Printer properties].

3 Click on [Configuration].

4 Click on [Accounting].

5 Select [Enable Account Setup] in [Accounting System].

6 From [Account Mode], select [User].

7 Specify a user account (user name and password).

When displaying a dialog box to enter a user account every time a job is submitted:
1. Select [Prompt User for Entry when Submitting Job].
2. Select the checkboxes for [Display Last Entered User Details] and [Mask User ID (***)] as necessary.

When you use a Windows login name as your user name and normally use the same account:
1. Select [Always Use Default User Details].
2. From [Specify Job Owner Name], select [Use Login Name].
3. Configure [Passcode] settings.

When always using the same user account by specifying a user name manually:
1. Select [Always Use Default User Details].
2. From [Specify Job Owner Name], select [Enter owner name].
3. Configure [User ID] and [Passcode] settings.

8 Click on [OK].

9 Click on [Apply].

10 Click on [OK].
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Enabling Print Accounting on the Operator Panel

1 Press the  <Menu> button.

2 Press the + or , button, select [Security Settings], and press the  button.

3 Press the + or , button, select [Print Accounting], and press the  button.

4 Press the + or , button, select [Print Accounting], and press the  button.

5 Press the + or , button, select [On], and press the  button.

6 Turn off the machine, and then turn it on again.

Registering Users with Internet Services
Register with the machine the account information (user name and password) for users specified for the print 
driver or application.

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [Accounting] in the upper part of the screen.

5 Click on [User Accounts] > [Add].

6 Specify [User Name], [Password] and [Retype Password], then click on [Add].
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8.3.3 Setting Printing Restrictions on Each Registered User
To use this feature, settings in the printer driver/application, operator panel and Internet Services are re-
quired.

You can set the following restrictions:

- Permitting Printing Only in Black and White (page 8-12)

- Limiting the Number of Pages Printable in Color/Black and White (page 8-14)

Permitting Printing Only in Black and White

Configuring Authentication Settings on the Print Driver/Application
Specify account information (user name and password) that is required for authentication when printing from 
a print driver or an application.

This section describes the procedure using the PCL driver as an example.

1 Click on [Start] > [Windows System] > [Control Panel] > [View devices and printers] or [Devices and 
Printers].

2 Right-click on the machine icon, and select [Printer properties].

3 Click on [Configuration].

4 Click on [Accounting].

5 Select [Enable Account Setup] in [Accounting System].

6 From [Account Mode], select [User].

7 Specify a user account (user name and password).

When displaying a dialog box to enter a user account every time a job is submitted:
1. Select [Prompt User for Entry when Submitting Job].
2. Select the checkboxes for [Display Last Entered User Details] and [Mask User ID (***)] as necessary.

When you use a Windows login name as your user name and normally use the same account:
1. Select [Always Use Default User Details].
2. From [Specify Job Owner Name], select [Use Login Name].
3. Configure [Passcode] settings.

When always using the same user account by specifying a user name manually:
1. Select [Always Use Default User Details].
2. From [Specify Job Owner Name], select [Enter owner name].
3. Configure [User ID] and [Passcode] settings.

8 Click on [OK].

9 Click on [Apply].

10 Click on [OK].

Enabling Print Accounting on the Operator Panel

1 Press the  <Menu> button.

2 Press the + or , button, select [Security Settings], and press the  button.

3 Press the + or , button, select [Print Accounting], and press the  button.

4 Press the + or , button, select [Print Accounting], and press the  button.

5 Press the + or , button, select [On], and press the  button.

6 Turn off the machine, and then turn it on again.
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Registering Users and Setting Usage Restriction with Internet Service
Register user account information (user name and password) of users specified for the print driver or appli-
cation to the machine and set usages restrictions for printing. You must be logged in the Internet Services as 
an administrator to configure settings.

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [Accounting] in the upper part of the screen.

5 Click on [User Accounts] > [Add].

6 Specify [User Name], [Password] and [Retype Password], then click on [Add].

7 Click the added user account.

8 Click on [Edit].

9 Click on  next to [Color Prints], deselecting the check box.

10 Click on [OK].

Tips
- Color print jobs of users restricted from printing in color will be canceled. For not canceling a job and 

printing in black and white, refer to page 5-4.
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Limiting the Number of Pages Printable in Color/Black and White
Set the maximum number of pages that can be printed in color or in black and white.

Configuring Authentication Settings on the Print Driver/Application
Specify account information (user name and password) that is required for authentication when printing from 
a print driver or an application.

This section describes the procedure using the PCL driver as an example.

1 Click on [Start] > [Windows System] > [Control Panel] > [View devices and printers] or [Devices and 
Printers].

2 Right-click on the machine icon, and select [Printer properties].

3 Click on [Configuration].

4 Click on [Accounting].

5 Select [Enable Account Setup] in [Accounting System].

6 From [Account Mode], select [User].

7 Specify a user account (user name and password).

When displaying a dialog box to enter a user account every time a job is submitted:
1. Select [Prompt User for Entry when Submitting Job].
2. Select the checkboxes for [Display Last Entered User Details] and [Mask User ID (***)] as necessary.

When you use a Windows login name as your user name and normally use the same account:
1. Select [Always Use Default User Details].
2. From [Specify Job Owner Name], select [Use Login Name].
3. Configure [Passcode] settings.

When always using the same user account by specifying a user name manually:
1. Select [Always Use Default User Details].
2. From [Specify Job Owner Name], select [Enter owner name].
3. Configure [User ID] and [Passcode] settings.

8 Click on [OK].

9 Click on [Apply].

10 Click on [OK].

Enabling Print Accounting on the Operator Panel

1 Press the  <Menu> button.

2 Press the + or , button, select [Security Settings], and press the  button.

3 Press the + or , button, select [Print Accounting], and press the  button.

4 Press the + or , button, select [Print Accounting], and press the  button.

5 Press the + or , button, select [On], and press the  button.

6 Turn off the machine, and then turn it on again.
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Registering Users and Setting Usage Restriction with Internet Services
Register user account information (user name and password) of users specified for the print driver or appli-
cation to the machine and set usages restrictions for printing. You must be logged in the Internet Services as 
an administrator to configure settings.

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [Accounting] in the upper part of the screen.

5 Click on [User Accounts] > [Add].

6 Specify [User Name], [Password] and [Retype Password], then click on [Add].

7 Click the added user account.

8 Click on [Edit].

9 Enter the desired values for [Limit] under [Color Prints].

10 Enter the desired values for [Limit] under [Black & White Prints].

11 Click on [OK].
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8.3.4 Permitting Print Jobs Without Account Information
When [Print Accounting] is enabled, jobs for which account information (user name and password) is missing 
cannot be printed. When you wish to allow printing, enable [Unauthenticated User Print]. 

You can also permit only black-and-white printing.

The jobs without account information are the following:

- Jobs generated using other company's print drivers or utilities

- Jobs submitted using the following features:

- USB Direct Print
- AirPrint
- Mopria Print Service

Tips
- Even if a print driver or an application provided by us is used, jobs generated with the print driver's or 

application's user authentication settings disabled are regarded as jobs without account information.

Permitting Printing in Color/Black and White

1 Press the  <Menu> button.

2 Press the + or , button, select [Security Settings], and press the  button.

3 Press the + or , button, select [Print Accounting], and press the  button.

4 Press the + or , button, select [Unauthenticated UserPrint], and press the  button.

5 Press the + or , button, select [Enable], and press the  button.

6 Press the + or , button, select [Auto Color To Mono Print], and press the  button.

7 Press the + or , button, select [Off], and press the  button.

8 Turn off the machine, and then turn it on again.

Permitting Printing Only in Black and White

1 Press the  <Menu> button.

2 Press the + or , button, select [Security Settings], and press the  button.

3 Press the + or , button, select [Print Accounting], and press the  button.

4 Press the + or , button, select [Unauthenticated UserPrint], and press the  button.

5 Press the + or , button, select [Enable], and press the  button.

6 Press the + or , button, select [Auto Color To Mono Print], and press the  button.

7 Press the + or , button, select [On], and press the  button.

8 Turn off the machine, and then turn it on again.

8.3.5 Checking Printing Usage
Print a Printer Counter report to check the current settings of printing restrictions and the total number of 
printed pages.

dReference
For details on how to print an Accounting report, refer to page 9-12.
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8.4 Using the Encryption Feature
When the encryption feature is used, data can be encrypted for transmission to prevent data falsification. A 
digital certificate is required to use the machine's encryption feature.

Tips
- The machine supports the following kinds of digital certificates:

- Self-signed certificate created using Internet Services
- Certificate signed by the certificate authorities (CA)

- The machine can import the digital certificates of the following formats:
- PKCS#12 (DER encoded)
- PKCS#7 (for CSR) (DER encoded)

Use Internet Services to configure encryption feature.

8.4.1 Preparing for Encryption

Enabling the SSL/TLS Server Communication
Before using the encryption feature with digital certificates, enable the SSL/TLS server communication.

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [System] in the upper part of the screen.

5 Click on [Security].

6 Click on [SSL/TLS Settings].

7 Click on  for [HTTP - SSL/TLS Communication] to select the checkbox.

8 Click on [OK].
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9 Click on [Restart Now].

Generating a Digital Certificate
Setting procedure differs for self-signed certificate created using Internet Services and certificate signed by 
Certificate Authorities (CA).

Generating a Self-Signed Certificate

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [System] in the upper part of the screen.

5 Click on [Security].

6 Click on [Security Certificates].

7 Make sure that [Device Certificates] is selected, and click on [Create].

8 Click on [Create Self-Signed Certificate].

9 Select a digital signature algorithm from [Digital Signature Algorithm].

10 Select a public key size from [Public Key Length].

11 Set the certificate's period of validity from [Validity Period].

12 Click on [Create].

13 Click on [Close].
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Using a Certificate Signed by the Certificate Authorities (CA)
When using a certificate signed by the certificate authorities (CA), generate the certificate signing request 
(CSR), and receive the signed certificate from the certificate authorities (CA).

Generating the Certificate Signing Request (CSR)

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [System] in the upper part of the screen.

5 Click on [Security].

6 Click on [Security Certificates].

7 Make sure that [Device Certificates] is selected, and click on [Create].

8 Click on [Create Certificate Signing Request (CSR)].

9 Specify each item.

10 Click on [Create].

11 Click on [Download].

A CSR file is saved to your computer.

NOTICE
Once the CSR file is downloaded, do not download another CSR before you import the certificate. If 
you generate another CSR, the secret key stored in the machine does not match with the secret key 
included in the signed certificate, and you cannot import the certificate.

12 Click on [Close].
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13 Send the CSR file to the certificate authority (CA) and receive the CA-signed certificate.

% For details about how to send the CSR, follow the procedure specified by the certificate authority 
(CA).

Importing a Certificate Signed by the Certificate Authorities (CA)
NOTICE
Before importing a certificate file, backup the certificate file.

After importing a PKCS#12 format certificate, the secret key is not exported even if you perform exporting.

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [System] in the upper part of the screen.

5 Click on [Security].

6 Click on [Security Certificates].

7 Click on [Device Certificates], and select [Trusted Root CA Certificates] or [Intermediate CA Certifi-
cates].

8 Click on [Import].

9 Click on [Select] and select the files to be imported.

10 Enter a password corresponding to the certificate file to be imported.

The password is not necessary when importing a PKCS#7 format certificate, which has the filename 
extension of p7b.

11 Enter the password again to confirm it.

12 Click on [Import].
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Selecting the Certificate

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, + or the 
, button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], and press the  button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [System] in the upper part of the screen.

5 Click on [Security].

6 Click on [Security Certificates].

7 Click on [Click on Device Certificates], and select [Trusted Root CA Certificates], [Intermediate CA Cer-
tificates] or [Other Certificates].

8 Click the certificate you want to use.

9 Check the certificate.

% Make sure that [On] is displayed in the [Validity] column for the selected certificate.

10 Click on [Close].

11 Click on [SSL/TLS Settings].

12 Click [Device Certificate - Server], and then select the certificate to be used.

13 Click on [OK].

14 Click on [Restart Now].

15 Once the machine completes restart, click on [Refresh].

dReference
For details on deleting or exporting digital certificates, refer to page 12-33.
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8.4.2 Setting the Encryption Features
The following encryption features can be used:

- Encrypting the HTTP communication and the IPP printing

- Encrypting the SMTP communication

- Forcibly encrypting the IPP communication

- Wireless LAN connection with WPA-Enterprise

Encrypting the HTTP Communication and the IPP Printing
When the communication between the web browser and the machine is encrypted, enter the address in the 
address text box, starting with "https" instead of "http".

- Example of entering the IP address
https://192.0.2.1/ (for IPv4 network)
https://[2001:DB8::1234]/ (for IPv6 network)

- Example of entering the Internet address
https://myhost.example.com/

To encrypt the IPP communication (Internet printing), enter the URL of the machine, starting with "https" in-
stead of "http" when you add the machine to your computer.

Encrypting the SMTP Communication

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, press the 
+ or the , button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], then press the 

 button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [System] in the upper part of the screen.

5 Click on [Security].

6 Click on [SSL/TLS Settings].

7 Click on [SMTP - SSL/TLS Communication], and select your connection method.
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8 Click on [OK].

Forcibly encrypting the IPP communication

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, press the 
+ or the , button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], then press the 

 button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [System] in the upper part of the screen.

5 Click on [Security].

6 Click on [SSL/TLS Settings].

7 Click on  for [IPP - Only Over SSL/TLS] to select the checkbox.

8 Click on [OK].

9 Click on [Restart Now].

10 Once the machine completes restart, click on [Refresh].
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Wireless LAN Connection With WPA-Enterprise

For EAP-TLS

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, press the 
+ or the , button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], then press the 

 button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [Network] in the upper part of the screen.

5 Click on [Connection] > [Wi-Fi].

6 From [Security Settings] > [Encryption Type], select [WPA2 Enterprise].

% This can be used only when [Infrastructure] is specified for [Network Type].

7 From [Authentication Method], select [EAP-TLS].

8 Click [Root Certificate], and then select the root certificate.

9 Click on [Client Certificate], and then select the client certificate.

10 Configure [EAP-Identity] settings.

11 Click on [OK].

12 Click on [Restart Now].

13 Once the machine completes restart, click on [Refresh].
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For PEAPv0 MS-CHAPv2, EAP-TTLS/PAP or EAP-TTLS/CHAP

1 Enter IP address of the machine in the web browser and start Internet Services.

% To check the machine's IP address, press the  <Menu> button on the operator panel, press the 
+ or the , button, select [Network Settings] > [Ethernet] > [TCP/IP] > [IP Address], then press the 

 button.

2 Click on [Log In] in the upper right part of the screen.

3 Enter the [User Name] and [Password] for the administrator, and click on [Log In].

% For details on the default user name and password, refer to page 8-4.

4 Click on [Network] in the upper part of the screen.

5 Click on [Connection] > [Wi-Fi].

6 From [Security Settings] > [Encryption Type], select [WPA2 Enterprise].

% This can be used only when [Infrastructure] is specified for [Network Type].

7 From [Authentication Method], select [PEAPv0 MS-CHAPv2], [EAP-TTLS/PAP] or [EAP-TTLS/CHAP].

8 Click [Root Certificate], and then select the root certificate.

9 Configure [EAP-Identity], [Login Name], [Password] and [Retype Password].

10 Click on [OK].

11 Click on [Restart Now].

12 Once the machine completes restart, click on [Refresh].
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9 Maintenance

9.1 Replacing Consumables
The following consumables are supplied as the replaceable items.

- Toner cartridge

- Drum cartridge

- Waste toner box

When the time for replacing a consumable part approaches, a message appears on the display.

For details on replacement procedures, refer to the packaging containing the consumable part.

7WARNING
- Do not throw toner or a container that contains toner (e.g., toner cartridge, developing unit and Waste 

Toner Box) into an open flame. The hot toner may scatter and cause burns or other damage.

7CAUTION 
- Do not leave toner-related parts (e.g., toner cartridge, developing unit and Waste Toner Box) within easy 

reach of children. Licking any of these parts or ingesting toner could damage your health.

- Do not store toner-related parts (e.g., toner cartridge, developing unit and Waste Toner Box) near de-
vices susceptible to magnetism, such as precision equipment and data storage devices, otherwise they 
may malfunction. They could cause these products to malfunction.

- Do not force open the toner-related parts (e.g., toner cartridge, developing unit and Waste Toner Box). 
If toner tumbles from the toner bottle, take utmost care to avoid inhaling it or even getting skin contact.

- If toner lands on your skin or clothing, wash thoroughly with soap and water.

- If you inhale toner, move to a place with fresh air and gargle with a lot of water repeatedly. Should you 
get symptoms such as coughing, seek medical advice.

- If you get toner into your eyes, immediately rinse them with running water for over 15 minutes. Seek 
medical advice if irritation persists.

- If you swallow toner, rinse out your mouth and drink a few glasses of water. Seek medical advice if nec-
essary.

NOTICE
Your service representative will collect your used drum cartridge and used waste toner box. Put it in a black 
plastic bag and store it in a box by itself.

When replacing a drum cartridge, do not touch the areas indicated in the illustration. This could cause poor 
print quality.
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9.2 Cleaning the Machine

7CAUTION 
- The inside of this product has areas subject to high temperature, which may cause burns. When check-

ing the inside of the unit for malfunctions such as a paper misfeed, do not touch the locations (around 
the fusing unit, etc.) which are indicated by a "Caution HOT" caution label. A burn could result.

9.2.1 Cleaning Outside the Machine
NOTICE
Using volatile solvents such as benzine or thinner, or spraying with insecticide may cause discoloration, defor-
mation, or cracks on the covers or exterior.

Be cautious with water, since too much moisture could cause the machine to malfunction.

1 Wipe the exterior of the machine with a soft, moistened, and tightly-squeezed cloth.

NOTICE
Use only water or neutral detergent, and never use other solutions.

% When stains cannot be removed easily, wipe lightly with the soft cloth slightly moistened with a thin 
neutral detergent solution.

2 Wipe the moisture off with a dry soft cloth.
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9.2.2 Cleaning Inside the Machine

Cleaning the LED Print Head
If you have image quality problems such as stripes appearing on print output, clean the LED print head.

1 Confirm that the machine has stopped, and open the right side cover.

2 Release the toner cartridge lock.
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3 Remove all four toner cartridges.

4 Release the waste toner box lock.

5 Remove the waste toner box.

6 Remove the cleaning rod.



bizhub C3100i 9-7

9.2 Cleaning the Machine 9
7 Insert the cleaning rod into one of the four holes of the tabs on the drum cartridge until it stops, and 

then pull it out.

% Insert the cleaning rod with the pad side up.

8 Repeat step 7 for the remaining three holes.

9 Replace the cleaning rod.

10 Press the waste toner box into the machine until you hear a "click" sound.
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11 Align the protrusion on the underside of the toner cartridge with the indentation in the machine, then 
press the toner cartridge into the machine until you hear a "click" sound.

12 Load the remaining toner cartridges.

13 Close the right side cover.
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Cleaning the Paper Feeder Rollers
Paper jams may occur if paper does not feed correctly. To prevent problems, regularly clean the paper feed 
rollers of the Bypass Tray, Tray 1, and Tray 2 (Paper Feed Unit PF-P26) (optional).

Cleaning the Bypass Tray Paper Feeder Rollers

1 Turn off the machine.

% For details on how to turn the power supply off, refer to page 3-4.

2 Open the Bypass Tray.

3 Open the cover.

4 Wipe the paper feeder rollers with a soft dampened cloth, then close the cover.

5 Close the Bypass Tray.



9-10 bizhub C3100i

Cleaning the Machine9 9.2

6 Supporting the paper tray with both hands, pull it out completely.

7 Place a finger on the lever and press it downward.

8 Wipe the rollers in the machine with a soft dampened cloth.

NOTICE
Do not force the paper feeder rollers to rotate. Doing so may damage the machine.

9 Insert the paper tray into the machine main unit, and press it in slowly until it stops.
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Cleaning the Paper Feeder Rollers of Tray 1, Tray 2 (Paper Feed Unit PF-P26) 
(Optional)

1 Turn off the machine.

% For details on how to turn the power supply off, refer to page 3-4.

2 Supporting the paper tray with both hands, pull it out completely.

3 Manually rotate the paper feeder rollers while gently wiping them with a soft dampened cloth.



9-12 bizhub C3100i

Counting up the Number of Printed Pages9 9.3

4 Manually rotate the rollers in the machine while gently wiping them with a soft dampened cloth.

NOTICE
Do not place the machine on its side. Doing so may spill toner.

Do not touch any other internal parts of the machine. Doing so may damage the machine.

5 Insert the paper tray into the machine main unit, and press it in slowly until it stops.

9.3 Counting up the Number of Printed Pages
The total number of printed pages can be checked by counter, by user, or by paper size. One-sided print is 
counted as one job, and two-sided print is counted as two.

9.3.1 Checking by Counter
There are three counters classified according to color mode.

1 Press the  <Menu> button.

2 Press the + or , button, select [Billing Counters], and press the  button.

dReference
For details on each counter, refer to page 7-7.

9.3.2 Checking by User or Paper Size
Check the number of pages on the printed report.

Tips
- When [Print Accounting] is disabled, you can check the output page count for each paper size.

- When [Print Accounting] is enabled, prints from jobs for which there is no account information will be 
included as [Unauthenticated User Print] in the report.

1 Press the  <Menu> button.

2 Press the + or , button, select [Information Pages], and press the  button.

3 Press the + or , button, select [Printer Counter], and press the  button.
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9.4 Adjusting Image Position ([Image Position])
If the output image is misaligned, enter the adjustment value to make the correction.

9.4.1 Printing a Chart

1 Load either of the following paper sizes into the paper tray to be adjusted.

8.5 e 11 v
A4 v

2 Press the  <Menu> button.

3 Press the + or , button, select [Maintenance], and press the  button.

4 Press the + or , button, select [Image Position], and press the  button.

5 Press the + or , button, select [Print Chart], and press the  button.

6 Press the + or , button, select the tray for adjustment, and press the  button.

7 Press the + or , button, select [1-Sided] or [2-Sided], and press the  button.

8 When an execution confirmation message appears, press the  button.

A chart will be printed.

9 Check the printed chart.

If the output image is aligned properly, a line will be printed 10 mm from the edge of the paper. If the 
line is misaligned, adjustment is necessary.

Tips
- A square symbol is printed on the trailing edge of the paper to display the paper feed direction. One 

square is printed on the front side, and two squares are printed on the back side.

Paper feed direction
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- When adjustment of [Lead/Side Registration] is necessary

- When adjustment of [Perpendicularity] is necessary

dReference
For details on adjustment of [Lead/Side Registration], refer to page 9-15.

For details on adjustment of [Perpendicularity], refer to page 9-16.

Desired image

Current image

Side registration misalignment

Lead registration misalignment

Fast scan direction

Slow scan direction
(Paper feed direction)
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9.4.2 Adjusting [Lead/Side Registration]
With [Lead/Side Registration], you can adjust front and back sides for each tray.

1 Check the chart, and measure the amount (mm) of misalignment in the image position.

Adjustment amount (mm) = distance (mm) of the actual image position from the edge of the paper -10

2 Press the  <Menu> button.

3 Press the + or , button, select [Maintenance], and press the  button.

4 Press the + or , button, select [Image Position], and press the  button.

5 Press the + or , button, select [Lead/Side Registration], and press the  button.

6 Press the + or , button, select the tray for adjustment, and press the  button.

7 Press the + or , button, select [Side1] or [Side2], and press the  button.

8 Press the + or , button, select [Lead Regi] or [Side Regi], and press the  button.

9 Specify a value comprising the misalignment amount confirmed in step 1 added to the current settings 
value, and press the  button.

Lead Registration
If the image in the step 1 diagram shifts downward, specify a positive value. If it shifts upward, specify 
a negative value.

Side Registration
If the image in the step 1 diagram shifts to the left, specify a positive value. If it shifts to the right, specify 
a negative value.

10 Print a chart when needed to check the adjustment results.

dReference
For details, refer to page 9-13.

Desired image

Current image

Side registration misalignment

Lead registration misalignment
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9.4.3 Adjusting [Perpendicularity]
At [Perpendicularity], you can adjust both the front and back sides, but the adjustments will affect all trays.

1 Check the chart, and measure the amount (mm) of misalignment in the image position.

% Use the following formula to obtain the amount of perpendicularity misalignment, with the leading 
edge of the paper facing upward, "A" representing the lead registration length (mm) of the left edge 
and "B" representing the lead registration length (mm) of the right edge.

Amount of perpendicularity misalignment (mm) = (A-B) x 216 / (main scanning direction mm - 20)

2 Press the  <Menu> button.

3 Press the + or , button, select [Maintenance], and press the  button.

4 Press the + or , button, select [Image Position], and press the  button.

5 Press the + or , button, select [Perpendicularity], and press the  button.

6 Press the + or , button, select [Side1] or [Side2], and press the  button.

7 Specify a value comprising the print position misalignment amount confirmed in step 1 added to the 
current settings value, and press the  button.

If the image forms a parallelogram that slopes down to the right when the leading edge of the paper is 
facing upward and you want to correct it to a rectangle, enter a negative value. If the parallelogram to 
be corrected slopes down to the left, enter a positive value.

8 Print a chart when needed to check the adjustment results.

dReference
For details, refer to page 9-13.

Fast scan direction

Slow scan direction
(Paper feed direction)
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9.5 Adjusting Color Registration ([Adjust Color Registration])
If color registration is misaligned in print output, adjust color registration (color registration misalignment) ei-
ther automatically or manually. Perform manual adjustment by printing a chart when a left-right difference in 
color registration misalignment amount (tilt) occurs.

9.5.1 Adjusting Automatically

1 Press the  <Menu> button.

2 Press the + or , button, select [Maintenance], and press the  button.

3 Press the + or , button, select [Adjust Image Quality], and press the  button.

4 Press the + or , button, select [Adjust Color Registration], and press the  button.

5 Press the + or , button, select [Auto Registration], and press the  button.

6 When an execution confirmation message appears, press the  button.

Color registration will be corrected automatically.

9.5.2 Adjusting Manually

1 Load either of the following paper sizes into the paper tray to be adjusted.

8.5 e 11 v
A4 v

2 Press the  <Menu> button.

3 Press the + or , button, select [Maintenance], and press the  button.

4 Press the + or , button, select [Adjust Image Quality], and press the  button.

5 Press the + or , button, select [Adjust Color Registration], and press the  button.

6 Press the + or , button, select [Manual Registration], and press the  button.

7 Press the + or , button, select [Print Chart], and press the  button.

8 When an execution confirmation message appears, press the  button.

A chart will be printed.
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9 Check the printed chart.

Reference lines are located on both sides of the chart. Look to both sides of a given color, and confirm 
the value at which the black and colored lines are most closely aligned.

If the numerical values at left and right differ, enter each observed value to make the adjustment. If the 
numerical values are the same (same degree of misalignment), adjustment is not necessary. You can 
enter numerical values between those printed on the chart, for adjustments at one-integer increments 
from +10 to -10.

10 Select [Enter Adjustment Value], and press the  button.

% Once back at the Print screen, perform steps 2 - 6.

11 Select the items requiring adjustment from among the values confirmed in step 9.

12 Specify the confirmed values, and press the  <Back> button to return to the previous screen.

13 Repeat steps 2 - 8 as needed, printing a chart to check the adjustment results.

Confirmation lines Confirmation lines
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9.6 Adjusting Print Head Density (1 Stripe)
This can be used when streaks (lines) about 1 mm wide appear in print output. Print a chart to make adjust-
ments.

Tips
- When no change occurs despite adjustment, it is necessary to restore the pre-adjustment value. Make 

a note of the pre-adjustment values, since the value on the input screen reverts to 0 after adjustment.

1 Load either of the following paper sizes into the paper tray to be adjusted.

8.5 e 11 v
A4 v

2 Press the  <Menu> button.

3 Press the + or , button, select [Maintenance], and press the  button.

4 Press the + or , button, select [Adjust Image Quality], and press the  button.

5 Press the + or , button, select [PrintHeadDensity(1Stripe)], and press the  button.

6 Press the + or , button, select [Print Chart], and press the  button.

7 When an execution confirmation message appears, press the  button.

A chart will be printed.
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8 Look at the printed chart and check the color of the lines that appear.

If the pale lines of each color appear lighter than the adjacent ones, and the dark lines appear darker 
than the adjacent ones, adjust the value upward.

If the pale lines of each color appear darker than the adjacent ones, and the dark lines appear lighter 
than the adjacent ones, adjust the value downward.

The bottom-most part is for confirmation of the pale yellow line. Use it when the pale yellow line is dif-
ficult to see.

9 Select [Enter Correction Value], and press the  button.

% Once back at the Print screen, perform steps 2 - 5.

10 Select the color requiring adjustment, and specify the correction value.

11 Configure other colors as needed. Press the  button to return to the previous screen.

12 Repeat steps 2 - 7 as needed, printing a chart to check the adjustment results.
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9.7 Adjusting Print Head Density (Stripes)
Print a chart to make adjustments when regularly patterned streaks (vertical lines) of dark and light shading 
appear on print output. When striping occurs throughout, perform common correction. When striping occurs 
in a specific 10.8 mm (chip), correct that chip individually.

Tips
- Striping may occur in a specific chip for a specific color.

- When no change occurs despite adjustment, it is necessary to restore the pre-adjustment value. Make 
a note of adjustment values.

9.7.1 Printing a Chart

1 Load either of the following paper sizes into the paper tray to be adjusted.

8.5 e 11 v
A4 v

2 Press the  <Menu> button.

3 Press the + or , button, select [Maintenance], and press the  button.

4 Press the + or , button, select [Adjust Image Quality], and press the  button.

5 Press the + or , button, select [PrintHeadDensity(Stripes)], and press the  button.

6 Press the + or , button, select [Print Chart], and press the  button.

7 When an execution confirmation message appears, press the  button.

A chart will be printed.
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8 Check the printed chart.

10.8 mm width (chip) 1 10.8 mm width (chip) 20
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9.7.2 Performing Common Correction
When striping occurs throughout, perform common correction. When striping occurs in a specific line (chip), 
correct that line individually.

1 Press the  <Menu> button.

2 Press the + or , button, select [Maintenance], and press the  button.

3 Press the + or , button, select [Adjust Image Quality], and press the  button.

4 Press the + or , button, select [PrintHeadDensity(Stripes)], and press the  button.

5 Select [Chip Common Correction], and press the  button.

6 Select the color requiring adjustment, and specify the correction value.

% To make odd-numbered lines darker and even-numbered lines paler, enter a positive value. To 
make odd-numbered lines paler and even-numbered lines darker, enter a negative value.

7 Configure other colors as needed. Press the  <Back> button to return to the previous screen.

8 Print a chart to check the adjustment results as needed.

dReference
For details, refer to page 9-13.

9.7.3 Performing Individual Correction

1 Press the  <Menu> button.

2 Press the + or , button, select [Maintenance], and press the  button.

3 Press the + or , button, select [Adjust Image Quality], and press the  button.

4 Press the + or , button, select [PrintHeadDensity(Stripes)], and press the  button.

5 Select [Individual Chip Correction], and press the  button.

6 Select the color requiring adjustment and press the  button.

7 Specify a value for the [Chip No.] requiring adjustment and press the  button.

8 Specify the adjustment value and press the  button.

% To increase density, enter a positive value. To decrease density, enter a negative value.

9 Print a chart to check the adjustment results as needed.

dReference
For details, refer to page 9-13.
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10 Troubleshooting

10.1 Clearing Jams

7CAUTION 
- Do not forcibly remove paper or shreds jammed inside the machine.

Take particular care not to forcefully remove paper when it has wrapped around fusing unit parts or roll-
ers. This could cause burns or other injuries. Turn off the power switch immediately, and contact your 
service representative

10.1.1 Clearing Paper Jams

Clearing Rear Cover Paper Jams

1 Release the Rear Cover lock.

2 Slowly open the rear cover.
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3 Remove the jammed paper.

NOTICE
If the paper tears, make sure that there are no shreds in the machine.

4 Close the rear cover.

Clearing paper jams in Tray 1, Tray 2 (Paper Feed Unit PF-P26) (Optional)
This description uses the procedure for clearing a Tray 1 paper jam as an example.

1 Remove Tray 1.

2 Remove the jammed paper.

NOTICE
If the paper tears, make sure that there are no shreds in the machine.
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When it cannot be removed

1 Slowly open the rear cover.

2 Place a finger on the edge of the cover.

3 While holding your finger in place, raise the cover to open it.
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4 Remove the jammed paper.

Clearing Bypass Tray Paper Jams

1 Check the insertion opening for the Bypass Tray, and remove any jammed paper.

NOTICE
If the paper tears, make sure that there are no shreds in the machine.

2 Slowly remove Tray 1.
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3 Place a finger on the lever and press it downward.

4 Remove the jammed paper.

NOTICE
If the paper tears, make sure that there are no shreds in the machine.

When it cannot be removed

1 Slowly open the rear cover.
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2 Place a finger on the edge of the cover.

3 While holding your finger in place, raise the cover to open it.

4 Remove the jammed paper.
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10.2 Troubleshooting
This section describes how to solve the problems with the machine.

10.2.1 Menu Settings Problems

10.2.2 Machine Problems

Problem Action

Menu settings changed from the operator 
panel have no effect.

Settings in the software, the print driver, or the printer 
utilities have precedence over the settings made on the 
operator panel.

Problem Possible Cause Action

The display is dark. Is the  (Power Supply / 
Power Saver) button illuminat-
ed?

The machine is in Power Saver mode. 
Press the  (Power Supply / Power 
Saver) button on the operator panel to 
leave Power Saver mode.

Unable to print. Is the memory full? Solve the problem by any of the following 
actions:
• Set [Image Quality] to [Standard] with 

the print driver
• Set unused ports to [Off].

Is the print driver in offline 
mode?

Open the printer icon and clear the check 
box for using the print driver in offline 
mode in the printer menu.

Are any restrictions applied to 
the jobs that can be printed on 
this machine?

Set [Restriction for Print Jobs] to [Off], or 
execute Secure Print.

dReference
For details on [Restriction for 
Print Jobs], refer to 
page 7-15.

For details on Secure Print, 
refer to page 5-5.

Printing does not start in 
spite of the instruction.

Is the Ethernet cable or USB 
cable disconnected? Is the 
machine connected to the 
wireless network?

Check the Ethernet and USB cable con-
nections. When connecting to Wi-Fi, 
make sure that the necessary settings 
are configured.

dReference
For details on connecting 
with LAN and USB cables, re-
fer to page 3-5 or page 3-6.

For details on wireless LAN 
connections, refer to 
page 3-7.

Is the protocol to use enabled? Enable the protocol to use.

dReference
For details, refer to 
page 7-12.
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Paper is often jammed or 
wrinkled.

Is the paper tray mounted 
properly?

Mount the paper tray properly by insert-
ing it securely all the way into the ma-
chine.

dReference
For details, refer to page 4-9.

Is the paper damp? Replace the paper with new paper.

Is the paper curled? Turn over the paper in the paper tray, or 
replace the paper with new paper.

Are the paper and paper tray 
settings correct?

Specify the paper and paper tray accord-
ing to the loaded paper.

dReference
For details, refer to page 4-9.

Are any jammed sheets, 
scraps of paper or other for-
eign debris left inside the ma-
chine?

Open the cover of the machine or pull the 
paper tray to remove any shreds or for-
eign objects.

Is paper exceeding the maxi-
mum fill line in the paper tray?

Load paper in the paper tray so that it 
does not exceed the maximum fill line.

dReference
For details, refer to page 4-9.

Are the paper guides aligned 
properly?

Load the paper properly, and then align 
the paper guides with the paper so that 
the paper guides contact the paper light-
ly.

dReference
For details, refer to page 4-9 
or page 4-11.

Is the paper finely cut out? Some paper types may not be cut out 
finely. Flex and fan the paper well, and 
then load it again.

dReference
For details, refer to page 4-8.

Problem Possible Cause Action
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10.2.3 Print Quality Problems

Problem Possible Cause Action

The printed result is too 
light (faded, unclear).

The paper is damp. Replace the paper with new paper.

The drum cartridge has deteri-
orated or been damaged.

Replace the drum cartridge with a new 
one.

No toner is left in the toner car-
tridge.

Replace the toner cartridge with a new 
one.

Black spots appear in 
printouts.

The drum cartridge has deteri-
orated or been damaged.

Replace the drum cartridge with a new 
one.

Black or colored lines ap-
pear in printouts.

The drum cartridge has deteri-
orated or been damaged.

Replace the drum cartridge with a new 
one.

The document is dirty. Clean the document.

Dirt appears at regular in-
tervals in the printout.

The paper feed path gets 
stained.

Print several sheets.

The drum cartridge has deteri-
orated or been damaged.

Replace the drum cartridge with a new 
one.
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White spots appear in ar-
eas of black fill.

The paper is unsuitable. Load the correct type of paper.

The drum cartridge has deteri-
orated or been damaged.

Replace the drum cartridge with a new 
one.

The printout comes off on 
the fingers.
The toner is not fused to 
the paper.
The paper gets stained 
with toner.

The paper is damp. Replace the paper with new paper.

The paper is unsuitable. Load the correct type of paper.

The specified paper type does 
not match the type of the paper 
loaded in the tray.

Specify the paper type correctly.

dReference
For details, refer to page 4-8.

The entire printout is 
black.

The drum cartridge has deteri-
orated or been damaged.

Replace the drum cartridge with a new 
one.

A high-voltage power supply 
failure may have occurred.

Contact your service representative.

The printout is blank. Multiple sheets of paper are 
fed through the machine at 
once (double feeding).

Flex and fan the paper well, and then 
load it again.

A high-voltage power supply 
failure may have occurred.

Contact your service representative.

The printout contains 
white areas, or white or 
colored stripes.

The paper is damp. Replace the paper with new paper.

The paper is unsuitable. Load the correct type of paper.

Problem Possible Cause Action
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The entire printout is faint. When printing using the By-
pass Tray, the paper size spec-
ified in the print driver is 
different from the size and type 
of the paper actually loaded.

Load the Bypass Tray with the correct 
type and size of paper.

dReference
For details, refer to 
page 4-11.

Multiple sheets of paper are 
fed through the machine at 
once.

Flex and fan the paper well, and then 
load it again.

dReference
For details, refer to page 4-8.

A high-voltage power supply 
failure may have occurred.

Contact your service representative.

The paper is wrinkled. The paper is unsuitable. Load the correct type of paper.

Paper has been added to the 
paper loaded.

Replace the paper with new paper.

The paper is damp.

Text is blurry. The paper is unsuitable. Replace the paper with new paper.

Paper has been added to the 
paper loaded.

The paper is damp.

Vertical patterns of une-
ven density appear in half-
tone images.

The paper is dry. With [Adjust 2nd BTR], decrease the val-
ue to decrease the voltage.

dReference
For details, refer to 
page 7-15.

White or color patches 
appear vertically.

The internal components of the 
machine may be soiled.

Use the cleaning rod to clean the inside 
of the machine, print a demo page, and 
check the output result.

dReference
For details, refer to page 9-5.

The drum cartridge has deteri-
orated or been damaged.

Replace the drum cartridge with a new 
one.

No toner is left in the toner car-
tridge.

Replace the toner cartridge with a new 
one.

Problem Possible Cause Action
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10.2.4 Printing Problems

Unable to Print

Print Output Problems

The printout is slanted. The paper guides of the paper 
tray are not aligned properly.

Align the horizontal and vertical paper 
guides properly.

dReference
For details, refer to page 4-9 
or page 4-11.

Problem Possible Cause Action

Problem Possible Cause Action

Data remains in the printer 
icon.

The machine is turned off. Turn on the machine.

The Ethernet cable on the 
computer is disconnected.

Connect the Ethernet cable to the com-
puter.

The computer is not connected 
to the wireless network.

Connect the computer to the wireless 
network.

The cable of the machine is 
disconnected or the machine is 
not connected to the wireless 
network.

Connect the cable to the machine. When 
connecting to Wi-Fi, make sure that the 
necessary settings are configured.

dReference
For details on connecting 
with LAN and USB cables, re-
fer to page 3-5 or page 3-6.

For details on wireless LAN 
connections, refer to 
page 3-7.

An error has occurred on the 
machine.

Check the error information, and take the 
required action.

The protocol to use is not ena-
bled.

Enable the protocol to use.

dReference
For details, refer to 
page 7-12.

The machine is connected to 
multiple computers.

Wait for a while and try printing again.

Problem Possible Cause Action

Unable to print in color. The machine is specified to 
print color jobs in black and 
white forcibly.

Set [Auto Color To Mono] Print to [Off].

dReference
For details, refer to page 5-4.

The image at the edges of 
the paper is missing.

The document exceeds the 
printable area of the machine.

Enlarge the print area of the machine, or 
reduce that of the document.
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10.2.5 Wireless Problems

10.2.6 Wi-Fi Direct Problems

Problem Action

Cannot set up wireless con-
nection.

Check to ensure that [Wi-Fi] is enabled.

dReference
For details, refer to page 7-9.

The firewall on your computer may be blocking communication with your 
machine. Disable the firewall on your computer.

Unable to set up wireless 
connection with WPS.

Make sure that the security settings of the access point or wireless router 
is WPA or WPA2. WEP is not supported on WPS.

Make sure that the access from the MAC address of the machine is not 
restricted on your access point or wireless router.

dReference
For details on the operations of your access point or wireless 
router, see the manual supplied with the access point or wire-
less router.

Unable to set up wireless 
connection with WPS (push 
button method).

Press the WPS button on the access point or wireless router within 2 
minutes after starting the WPS operation on the machine.

dReference
For details about the access point or wireless router, see the 
manual supplied with the access point or wireless router.

Unable to set up wireless 
connection with WPS (PIN 
code method).

Make sure that you have entered the correct PIN on the access point or 
wireless router.

dReference
For details about how to enter the PIN code, see the manual 
supplied with the access point or wireless router.

The network mode of the ma-
chine cannot be set to an Ad-
hoc mode.

Check to ensure that [Wi-Fi] is enabled.

dReference
For details, refer to page 7-10.

Problem Action

The mobile device cannot 
discover the machine.

The machine may be connected to another mobile device via Wi-Fi Di-
rect. Disconnect the machine and the mobile device.

dReference
For details, refer to page 6-5.

Unable to connect the mobile 
device with the machine.

When connecting to the machine using the Wi-Fi Direct feature of an An-
droid device, set the machine's [Group Role] to [Group Owner].

dReference
For details, refer to page 7-10.

The mobile device cannot be 
disconnected from the ma-
chine, even by performing 
the procedure for Discon-
necting the Mobile Device 
From the Wi-Fi Direct Net-
work. (page 6-5)

The mobile device may be automatically reconnecting to the machine. 
Reset the passphrase for Wi-Fi Direct and disconnect the mobile device.

dReference
For details, refer to page 6-5.

Enable [Wi-Fi Direct]. Make sure that the network mode is set to an infrastructure mode.

Check to ensure that [IP Mode] is set to a mode other than [IPv6].
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10.2.7 IPv6 Environment Problems

10.3 Understanding Machine Messages
When the operation finishes abnormally due to an error or when problems occur on the machine, the operator 
panel displays error messages and the status codes (***-***). Solve the problems, referring to the status codes 
in the following list.

Tips
- When the displayed error code is not included in the following list, follow the instructions in the error 

message displayed on the operator panel. If you cannot solve the problem after following the instruc-
tions in the list or operator panel error message, contact your service representative.

Problem Action

Unable to set an IP address 
for IPv6.

Check to ensure that [Wi-Fi Direct ]is disabled.

dReference
For details, refer to page 7-10.

Status Code What you can do

016-404 There is a problem with the certificate. Contact your system administra-
tor. Press the  button to begin initialization.

016-405

016-520 The certificate of the machine is invalid. Contact your system adminis-
trator.

016-521 The certificate of the destination client is invalid. Contact your system 
administrator.

016-522 Unable to acquire the SSL certificate. Contact your system administra-
tor.

016-523 The SSL certificate data is incorrect. Contact your system administrator.

016-524 The validity period of the SSL certificate has expired. Contact your sys-
tem administrator.

016-541 A wireless certificate of the server or client cannot be correctly refer-
enced while using Wireless LAN Mixed Mode Enterprise or WPA2-Enter-
prise. Ask your system administrator to connect the machine with a 
wired network, and then initialize the wireless settings. After that, import 
the wireless certificate, and then set Mixed Mode Enterprise or WPA2-
Enterprise again.

016-542 A server certificate error has occurred when acquiring the certificate with 
the operation of Mixed Mode Enterprise or WPA2-Enterprise. This is a 
problem in the server certificate, such as the validity period has expired 
for the server certificate being used with the Radius server. Ask your sys-
tem administrator to check the server certificate being used with the Ra-
dius server.

016-543 A wireless certificate of the server or client corruption error has occurred 
while using the Wireless LAN Mixed Mode Enterprise or WPA2-Enter-
prise. Ask your system administrator to connect the machine with a 
wired network, and then initialize the wireless settings. After that, import 
the wireless certificate, and then set Mixed Mode Enterprise or WPA2-
Enterprise again.

016-718 An error has occurred when there is insufficient memory to print. The 
print job is canceled. Reduce the data size of the print job.

016-720 Incompatible Page Description Language (PDL) is included. Use the ma-
chine's print driver.

dReference
For details on how to install print drivers, refer to page 3-13 
or page 3-16.

016-757 The account is not registered. Contact your system administrator.
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016-759 Printable page limit is exceeded. Contact your system administrator.

016-799 The job is invalid. Check the configuration of the machine on the print 
driver.

016-924 When specifying the encryption type as WEP and connecting to a wire-
less network, [Quick Setup] cannot be used to configure wireless net-
work settings. If the wireless network access point encryption type is 
WEP, configure the wireless network settings from the machine's oper-
ator panel.

dReference
For details on wireless network settings, refer to page 3-8.

027-446 IPv6 address is overlapped. Change the IPv6 address.

027-452 IPv4 address is overlapped. Change the IPv4 address.

Status Code What you can do
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11 Installing Optional Accessories

11.1 Installing the Paper Feed Unit PF-P26 (Tray 2)

11.1.1 Installing the Paper Feed Unit PF-P26 (Tray 2)

1 Press the  (Power Supply / Power Saver) button to turn the power off.

2 Disconnect the power cord from the power outlet and from the machine main unit.

3 Position the Paper Feed Unit PF-P26 (Tray 2) for installation.

4 Lift the machine main unit as shown in the illustration.

NOTICE
The main unit should always be lifted by two or more people.

5 Make sure that the front surface and corners of the Paper Feed Unit PF-P26 (Tray 2) align with those 
of the machine, and gently lower it into place.

NOTICE
Installation with the machine and Paper Feed Unit PF-P26 (Tray 2) at different angles could result in 
damage to the machine.
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11.1.2 Configure Settings with the Print Driver
Networked print options and paper tray information are reflected in the print driver settings.

1 Click on [Start] > [Windows System] > [Control Panel] > [View devices and printers] or [Devices and 
Printers].

2 Right-click on the machine icon, and select [Printer properties].

3 Click on the [Configuration] tab, and click on [Bi-Directional Setup] > [Get Information from Printer] > 
[OK].

4 Click on [Apply] > [OK].

Tips
- If the printer information is not updated when you click on [Get Information from Printer], configure using 

the [Configuration] tab > [Installable Options].



12 Internet Services Help





bizhub C3100i 12-3

12.1 About Internet Services 12

12 Internet Services Help

12.1 About Internet Services
Describes the basic features of Internet Services and information you need to know before using Internet Ser-
vices.

12.1.1 Overview of Internet Services
Internet Services is a service that allows you to display the printer status and job history as well as configure 
printer settings from a web browser.

Internet Services is available on the computer connected to the printer in the TCP/IP network environment.

Tips
- Some settings become available when you restart the printer from Internet Services or manually turn 

off and on the printer on the operator panel of the printer.

- The names of setting items with an asterisk (*) on upper right indicates the setting that you must enter.

Page Configuration
The page of Internet Services is displayed as follows according to the window size of the web browser.

When the Window Size Is the Large Screen
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When the Window Size Is the Small Screen

12.1.2 Setting Up Your Web Browser
The following settings are needed on your web browser before using Internet Services.

The following procedure uses Microsoft Edge as an example.

Specifying the Proxy Server So That the IP Address of the Machine Is Treated 
as Exception

1 Click [...] > [Settings].

The [Settings] menu appears.

2 Click [System and performance] > [Open your computer’s proxy settings].

The [Proxy] window is displayed.

3 Turn off [Use a proxy server] of [Manual proxy setup].

4 Click [Save].

Enabling JavaScript

1 Click [...] > [Settings].

The [Settings] menu appears.

2 Click [Cookies and site permissions] > [Site permissions] > [JavaScript].

The [Site permissions / JavaCript] window is displayed.

3 Enable [Allowed (recommended)].

No. Description

1 Displays menus and the user login status.
For the small screen, clicking  displays menu.

2 Displays items of the selected menu.
For the small screen, [Details] is displayed as  and [Settings] as .
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12.1.3 Logging In/Logging Out
When enabling [Administrator Mode] in [Administrator Settings] on [System], you may be prompted to login 
as the system administrator when using some functions in Internet Services. Use the user name and the 
password for the system administrator registered on the printer.

NOTICE
Change the administrator name and password immediately after installation.

dReference
For details, refer to page 12-35.

Loggin In
When the Window Size Is the Large Screen

1 Click [Log In] on the upper right corner.

2 Enter [User Name] and [Password], and then click [Log In].

When the Window Size Is the Small Screen

1 Click  on the upper left corner.

2 Click [Log In].

3 Enter [User Name] and [Password], and then click [Log In].

Loggin Out
When the Window Size Is the Large Screen

1 Click [Administrator] on the upper right corner.

2 Click [Log Out].

When the Window Size Is the Small Screen

1 Click  on the upper left corner.

2 Click [Administrator].

3 Click [Log Out].
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12.1.4 Entering Characters/Numbers/E-Mail Addresses/Passwords
Note the following when entering characters, numbers, e-mail addresses, and passwords.

Entering Characters/Numbers
In this Help, the maximum number of characters that you can enter is described in bytes in some cases.

When you enter characters, it may be useful to know that UTF-8 encoding uses 1 to 6 bytes to express one 
character.

NOTICE
Even if the character string that you enter are displayed in text boxes, the entire characters may not be saved.

Entering E-Mail Addresses
Note the following when entering e-mail addresses:

- Enter the e-mail address with "local portion@domain" portion or "local portion" format.

- Do not use a period (.) at the beginning or end of each portion, or two or more consecutive periods.

- In the "local portion", use alphanumeric characters and the following symbols:
! # $ % & ' * + - / = ? ^ _ ` { | } ~

- In the "domain portion", use alphanumeric characters, periods (.), and hyphens (-).

Entering Passwords
Regardless of whether it is already entered or not, such as circles (•) are displayed in text boxes.

Delete all the circles when entering the new password.

12.1.5 Certificates and Security
When using Internet Services, a certificate may be required. High-security communication becomes possible 
using the certificate.

Encrypting Data
The data transmitted between the printer and a web browser is encrypted when a certificate is created in 
[Security] on [System], and [HTTP - SSL/TLS Communication] is enabled.

dReference
For details, refer to page 12-33.
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12.2 Home
Describes such as the printer information, status of the output tray/supplies, printed page numbers, and sup-
port information.

12.2.1 Device Information
You can check the status and information of the printer.

Printer Status
Displays the status of the printer.

- [Device: Ready]

- [Check Device status at Notifications on the Home Screen]

- [Device: Sleeping]

[Device Name]/[IP Address]/[Location]/[System Administrator]/[Wi-Fi]
Displays the information of the printer settings. [Wi-Fi] appears when [Wi-Fi] or [Wi-Fi Direct] is specified.

[Details]
Displays the [Device Details] dialog box.

Setting Description

[Device Name] Displays the name of the printer. You can also change 
the name. The following characters can be entered:
• Up to 31 bytes

[Software Version] Displays the software version of the printer.

[Serial Number] Displays the serial number of the printer.

[Location] [Location] Displays the location of the printer. The following char-
acters can be entered:
• Up to 63 bytes

[Network] Displays the information of network connection on 
each connection.

[Host Name] Displays the host name of the printer.

[IPv4 Address] Displays the IPv4 address of the printer.

[IPv6 Link-Local Ad-
dress]

Displays the IPv6 link-local address of the printer.
If Wi-Fi Direct is used, this item is not displayed.

[System Administrator]

[Name] Enter contact information such as the telephone num-
ber of the administrator or service center. The follow-
ing characters can be entered:
• Up to 63 bytes

[Email Address] Enter the e-mail address of the administrator of Inter-
net Services. The following characters can be entered:
• Up to 64 bytes

Note
You can use this item for recording-keeping. No e-mail 
is sent to this address from the printer.
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12.2.2 [Notifications]
You can check the status of the printer.

[Settings]
Displays the [Notification Settings] dialog box.

12.2.3 [Supplies]
Displays the remaining amount of each toner. Clicking the icons of each toner displays the details of the toner 
cartridge.

[Details]
Displays the details of each supply.

12.2.4 [Trays]
You can check the settings of each paper tray. Clicking the icons of each paper tray displays the details of 
tray dialog box.

[Details of Tray Dialog Box]
Displays the size and type of the paper loaded in each paper tray, and the status of the trays. "-" is displayed 
when the information cannot be obtained.

12.2.5 [Counter]
You can check the information of the pages printed on the printer.

[Black Printed Impressions]
Displays the total number of monochrome pages printed to date.

[Color Printed Impressions]
Displays the total number of color pages printed to date.

[Total Printed Impressions]
Displays the total number of all the pages printed to date.

Setting Description

[Email Notification 1]/[Email Notification 2] The notification is sent to the specified e-mail ad-
dress when the printer becomes the selected sta-
tus.

[Destination] Enter the e-mail address to send the notifications. 
The following characters can be entered:
• Up to 64 bytes

Setting Description

[Supplies Details] Clicking the item displays the details.
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12.2.6 [Quick Links]
You can check the useful functions and links to use the printer.

[Cloning]
The following data are imported/exported.

- Configuration information

NOTICE
The import destination device must be the same model and software version as that of the export source de-
vice.

The import destination device must be connected to the same subnet as that of the export source device.

The export source device functions (Wi-Fi) that require a client certificate must be disabled.

If the function that uses a server certificate (such as HTTPS and IPPS) is enabled on the export source device, 
import the external certificate to the import destination device before importing the data.

If [IP Addressing] is set to [Manual Input] on the operator panel of the export source device, set the IP address 
on the operator panel of the import destination device after importing the data.

Setting Description

[Install Clone File] To capture configuration information files, click the [Browse] button to 
specify the configuration information files you want to capture, and then 
click the [Install] button.

Note
- Before importing data, enable [Software Download] in the security 

settings on the operator panel of the import destination device.
- Do not turn off the device during import.

dReference
If the import is performed while the jobs are running, the im-
port will be processed after all the current jobs are pro-
cessed.

If the import fails, the recovery process will be performed au-
tomatically.

After the recovery process, perform the following operations 
on the operator panel to initialize the data.

• Select the  <Menu> button > [Maintenance] > [Initialize NVM] to 
initialize all items.

• Select the  <Menu> button > [Network Settings] > [Other] > [Re-
set Network Settings] to initialize the data.

• Select the  <Menu> button > [Security Settings] > [Print Account-
ing], and set [Print Accounting] to [Off].

[Create Clone File] To retrieve configuration information files, click the [Create] button to 
save information.
The device will restart after the export is processed.

Note
Jobs cannot be performed during the export.
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[Support]

12.3 Jobs
Describes how to check the list of the jobs.

12.3.1 [Jobs]
You can check the list of names of the user who requested the job, job names, job status, and page numbers. 
Clicking each job displays the details of the job dialog box.

Tips
If [Restrict Job Display Information] is set to [On] on the operator panel, some information is displayed in ci-
pher (hidden) characters.

Job Status
Displays the status and number of pages of the job being processed.

[Submitted By]
Displays the name of the user who requested the job. "-" is displayed when there is no user information.

[Submitted]
This item is displayed when the job is being processed.

Displays the date when the job was submitted.

[Completed]
This item is displayed when the job was processed.

Displays the date when the job was processed.

Setting Description

[Options]

[Restart Device] Restarts the printer.

[Online Support] Displays our official web site.

[Download OSS Li-
cense Information]

Download your license information. This allows you to 
check the license applied to each OSS and copyright no-
tices.
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12.4 Connectivity
Describes how to specify the network connection of the printer.

Tips
- This item appears if you login as the system administrator when [Administrator Mode] in [Administrator 

Settings] is enabled.

- The items of environment settings displayed differ depending on the products and the options installed.

12.4.1 [Ethernet]
You can specify the communication environment via Ethernet.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

[Ethernet]

[Common]
Displays host name, IP mode, and whether to make a priority to IPv6 over IPv4 at domain name resolution.

To edit the settings, click [Edit] to display the [Common] dialog box.

Setting Description

[MAC Address] Displays the MAC address.

[Rated Speed] Select the Ethernet transmission speed. Selecting [Auto (Default)] auto-
matically detects and switches the Ethernet transmission speed and Du-
plex setting.

[Energy Efficient Ethernet] Specify whether to enable Energy Efficient Ethernet.
Enabling this item reduces power consumption of the printer when the 
connected printer supports Energy Efficient Ethernet feature.

Setting Description

[Host Name] Displays the host name. The host name can also be changed. The fol-
lowing characters can be entered:
• Up to 47 bytes
• Alphanumeric characters and hyphens (-)

[Network] Select the Ethernet or Wi-Fi.

[IP Mode] Select the IP mode to be used.

Note
Wi-Fi Direct cannot be used when [IPv6] is selected.

[IPv6 Priority over IPv4 at Do-
main Name Resolution]

This item appears when [Dual Stack] is selected for [IP Mode].
Specify whether to make a priority to IPv6 over IPv4 at domain name res-
olution.
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[IPv4]
Displays the settings of the IPv4 address.

To edit the settings, click [Edit] to display the [IPv4] dialog box.

[IPv6]
Displays the settings of the IPv6 address.

To edit the settings, click [Edit] to display the [IPv6] dialog box.

Setting Description

[Mode] Select the mode to be used.

[IP Address] Displays the IP address.
When [STATIC] is selected for [Mode], enter the IP address that is allo-
cated to the printer.

[Subnet Mask] Displays the subnet mask.
When [STATIC] is selected for [Mode], enter the subnet mask.

[Gateway Address] Displays the gateway address.
When [STATIC] is selected for [Mode], enter the gateway address.

[Self-Assigned Address] This item appears when [DHCP] is selected for [Mode].
Specify whether to obtain the auto-set address.

Setting Description

[Link-Local Address] Displays a link-local address.

[DHCPv6]

[Purpose] Specify whether to enable the purpose for DHCPv6.

[Manual Address] Specify whether to manually set the IPv6 address.

Note
Obtaining of auto-set address is still performed even 
when this item is enabled.

[Manual Address] This item appears when [Manual Address] is enabled.
• Text Box on the Left: Enter the IP address allocat-

ed to the printer.
• Text Box on the Right: Enter the prefix length allo-

cated to the printer.

[Gateway Address] This item appears when [Manual Address] is enabled.
Enter the gateway address.

[Automatically Con-
figured Gateway Ad-
dress]

This item appears when [Manual Address] is enabled.
Displays a gateway address assigned by the IPv6 rout-
er connected to the network.
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[DNS]
Displays the setting of DNS.

To edit the settings, click [Edit] to display the [DNS] dialog box.

Setting Description

[Domain Name] Enter the domain name. The following characters can 
be entered:
• Up to 255 bytes
• Alphanumeric characters, periods (.), and hyphens 

(-)

[Connection Timeout] Enter the connection timeout period of DNS. If the re-
ception of data stops during the transfer, the connec-
tion to the printer is terminated after the time period 
specified here elapses.

[IPv4 DNS Servers]

[Use DHCP to Assign 
Address]

Specify whether to obtain the IP address from DHCP.

[Server Address] This item appears when [Use DHCP to Assign Ad-
dress] is disabled.
Enter the DNS server address.

[IPv6 DNS Servers]

[Use DHCPv6-lite to 
Assign Address]

Specify whether to obtain the IP address from DH-
CPv6-lite.

[Server Address] This item appears when Use [Use DHCPv6-lite to As-
sign Address] is disabled.
Enter the DNS server address.

[DNS Search Do-
mains]

[Generate Domain 
Search List Automati-
cally]

Specify whether to automatically create the domain 
search list.

[Search Domain 
Name]

This item appears when [Generate Domain Search List 
Automatically] is disabled.
Enter the domain name to be searched.

[Dynamic DNS Regis-
tration]

Specify whether to update DNS dynamically.

[Dynamic DNS Regis-
tration (IPv4)]

When [Dual Stack] or [IPv4] is selected for [IP Mode] in 
[Common], specify whether to update DNS dynamical-
ly.

[Dynamic DNS Regis-
tration (IPv6)]

When [Dual Stack] or [IPv6] is selected for [IP Mode] in 
[Common], specify whether to update DNS dynamical-
ly.
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[802.1X]
Configure printer settings for enabling IEEE 802.1x authentication on your network. This function is available 
when your network environment supports IEEE 802.1x.

To edit the settings, click [Setup] to display the [802.1X] dialog box.

12.4.2 [Wi-Fi]
You can specify the communication environment via Wi-Fi.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

[Wi-Fi]

[TCP/IP Settings]
To edit the settings, click [Edit] to display [Ethernet]. (page 12-11)

Setting Description

[Enable 802.1X] Specify whether to enable the IEEE 802.1x protocol.

[Authentication Meth-
od]

This item appears when [Enable 802.1X] is enabled.
Select the authentication method for IEEE 802.1x.

[User Name (Device 
Name)]

This item appears when [Enable 802.1X] is enabled.
Enter the user name (printer name) for IEEE 802.1x au-
thentication. A null cannot be set. The following char-
acters can be entered:
• Up to 128 bytes
• Alphanumeric characters and symbols

[Password] This item appears when [Enable 802.1X] is enabled.
Enter the login password for IEEE 802.1x authentica-
tion. A null cannot be set. The following characters can 
be entered:
• Up to 128 bytes
• Alphanumeric characters and symbols

[Retype Password] This item appears when [Enable 802.1X] is enabled.
Enter the same character string in Password.

Setting Description

[MAC Address] Displays the current MAC address when the printer is connected to a 
wireless network.

[Link Channel] Displays the channel number of the connection when the printer is con-
nected to a wireless network.

[Link Quality] Displays the quality of the connection when the printer is connected to 
a wireless network.

[SSID] Enter the name to identify the wireless network. The following characters 
can be entered:
• Up to 32 bytes
• Alphanumeric characters and symbols

[Network Type] Select the network type.
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[Security Settings]

Setting Description

[Encryption Type] Select the security method. When you do not use en-
cryption, select [No Security].

When [WEP] Is Selected for [Encryption Type]

[Transmit Key] Select the WEP key to be used.

[WEP Key 1]/[WEP 
Key 2]/[WEP Key 
3]/[WEP Key 4]

Enter the WEP key.

[Retype WEP Key 
1]/[Retype WEP Key 
2]/[Retype WEP Key 
3]/[Retype WEP Key 
4]

Enter the same WEP key in each WEP key.

When [WPA2 Personal] or [Mixed WPA2 Personal] Is Selected for [Encryption 
Type]

[Passcode] Select the passcode to be used.

[Retype Passcode] Enter the same passcode in Passcode.

When [WPA2 Enterprise] or [Mixed WPA2 Enterprise] Is Selected for [Encryption 
Type]

[Authentication Meth-
od]

Select the authentication method

[Root Certificate] Select the certificate to be used.

[EAP-Identity] Enter the EAP-Identity.

[Login Name] Enter the login user name for WPA-Enterprise authen-
tication. The following characters can be entered:
• Up to 32 bytes
• Alphanumeric characters and symbols

[Password] Enter the password for WPA-Enterprise. A null cannot 
be set.

[Retype Password] Enter the same character string in [Password].
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12.4.3 [Wi-Fi Direct]
You can specify the communication environment via Wi-Fi Direct.

Tips
- Wi-Fi Direct cannot be used in an IPv6 or Ad-hoc environment.

- This setting becomes available when you restart the printer from Internet Services or manually turn off 
and on the printer on the operator panel of the printer.

[Wi-Fi Direct]

[DHCP Server]
This item appears when Wi-Fi Direct is enabled.

[Group Owner]
This item appears when Wi-Fi Direct is enabled and [Group Owner] is selected for [Group Role].

Displays the current group owner.

Setting Description

[Enable] Specify whether to enable the Wi-Fi Direct connection.

[Wi-Fi Direct Connection Sta-
tus]

The status appears when Wi-Fi Direct is enabled.
• [Paired Device]: Displays the number of mobile devices currently 

connected.
• [Current Role]: Displays the current group role of the printer.
• [Current SSID]: Displays the current SSID.

[Group Role] This item appears when Wi-Fi Direct is enabled.
Select the group role of the printer.

[Device Name] This item appears when [Auto] is selected for [Group Role].
Enter the printer name that identifies the Wi-Fi Direct network. The fol-
lowing characters can be entered:
• Up to 32 bytes
• Alphanumeric characters and symbols

Setting Description

[IP Address] Displays the IP address of the printer when connected using Wi-Fi Di-
rect.

[Subnet Mask] Displays the subnet mask of the printer when connected using Wi-Fi Di-
rect.

Setting Description

[SSID] Enter the name to be identified over the Wi-Fi Direct network. A null can-
not be set. The following characters can be entered:
• Up to 23 bytes
• Alphanumeric characters and symbols

[Passcode] Displays the passcode. Confirm it when you enter the passcode into 
your Wi-Fi mobile device.
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12.4.4 [Mobile Printing]
You can check the settings of Mobile Printing. You can edit the settings of each Mobile Printing in the setting 
dialog box displayed by clicking the item name.

Tips
- The ports displayed differ depending on the products and the options installed.

- This setting becomes available when you restart the printer from Internet Services or manually turn off 
and on the printer on the operator panel of the printer.

[AirPrint]
Displays whether the AirPrint setting of the printer is enabled.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

Setting Description

[Enable] Specify whether to enable the printer for AirPrint. Bon-
jour (mDNS) and IPP protocols are also available when 
AirPrint is enabled.

[USB Connection] This item appears when AirPrint is enabled on the 
printer.
Specify whether to enable the printer for USB port 
connection.

[Bonjour] This item appears when AirPrint is enabled on the 
printer.

[Printer Name] Enter the service name to be used on Multicast DNS. 
The following characters can be entered:
• Up to 63 bytes

[Location] Enter the name of the location of the printer. The fol-
lowing characters can be entered:
• Up to 63 bytes

[Geo-Location] Enter the physical location of the printer. The following 
characters can be entered:
• Up to 127 bytes

[IPP Authentication] This item appears when AirPrint is enabled on the 
printer.

[Basic Authentication] Specify whether to enable the authentication function 
for AirPrint.

[User Name] This item appears when [Basic Authentication] is ena-
bled.
Enter the user name for AirPrint. Control characters 
are not available. The following characters can be en-
tered:
• Up to 31 bytes
• Alphanumeric characters, symbols, and spaces

[Password] This item appears when [Basic Authentication] is ena-
bled.
Enter the password. Control characters are not availa-
ble. The following characters can be entered:
• Up to 31 bytes
• Alphanumeric characters, symbols, and spaces

[Retype Password] Enter the same character string in [Password].

[Security Certificates] This item appears when AirPrint is enabled on the 
printer.
Clicking [Edit] displays the [Security Certificates] dia-
log box. (page 12-29)
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[Mopria]
Displays whether the Mopria® setting of the printer is enabled.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

Specify whether to enable Mopria® on the printer to be used.

Bonjour (mDNS) and IPP protocols are also available when Mopria® is enabled.

12.4.5 [Protocols]
You can check whether the protocol settings are enabled. You can edit the settings of each protocol in the 
setting dialog box displayed by clicking the item name.

[Bonjour]
You can configure the settings for the Multicast DNS function.

NOTICE
If this setting conflicts with the setting of some other machine on the network, it may be overwritten by the 
setting of another machine.

[Supplies] This item appears when AirPrint is enabled on the 
printer.
Clicking Check Status displays the details of [Sup-
plies]. (page 12-8)

Setting Description

Setting Description

[Port] Specify whether to enable the Multicast DNS.

[Wide-Area Bonjour] This item appears when [Port] is enabled.
Specify whether to enable the Wide-Area Bonjour protocol.

[Host Name] This item appears when [Port] is enabled.
Enter the host name to be used on Multicast DNS. The following char-
acters can be entered:
• Up to 63 bytes
• Alphanumeric characters and hyphens (-)

[Printer Name] This item appears when [Port] is enabled.
Enter the printer name to be used on Multicast DNS. The following char-
acters can be entered:
• Up to 63 bytes
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[HTTP]
You can configure the settings for HTTP.

Setting Description

[Port Number] Enter the port number which accepts requests from 
your web browser.

Note
- Do not use the same port number as other pro-

tocols.
- This setting becomes available when you restart 

the printer from Internet Services or manually 
turn off and on the printer on the operator panel 
of the printer.

[CSRF Protection] Specify whether to enable the CSRF (Cross-site Re-
quest Forgery) protection.

Note
When CSRF Protection is enabled, HTTP referer is 
checked. Internet Services is not available depending 
on your network environment.

[HTTPS (SSL)] Specify whether to enable SSL/TLS server communi-
cation.

[HTTPS Port Number] This item appears when [HTTPS (SSL)] is enabled.
Enter the port number that accepts requests from your 
web browser. The default value is "443".
When the port number is changed, enter a colon (:) and 
the port number after the printer's IP address, and 
then access to Internet Services with the format of 
"https://Printer_IP_Address:Port_Number/".
Example: https://192.0.2.1:80/

Note
Do not use the same port number as other protocols.

[Connection Timeout] Enter the timeout period to wait for a response from 
the web browser.

[Proxy Server] Specify whether to enable the use of a proxy server.

[Type] This item appears when [Proxy Server] is enabled.
Select the type of the address.

[IP Address : Port] This item appears when [Proxy Server] is enabled and 
[IPv4] or [IPv6] is selected for [Type].
Enter the IP address that uses the proxy server and the 
port number.
• Text Box on the Left: Enter the IP address. The fol-

lowing characters can be entered:
- IP address or FQDN (Fully Qualified Domain 
Name) format
- Up to 255 bytes

• Text Box on the Right:  Enter the port number.

[Host Name : Port] This item appears when [Proxy Server] is enabled and 
[Host Name] is selected for [Type].
Enter the host name and the port number. The follow-
ing characters can be entered:
• Text Box on the Left: Enter the host name. The fol-

lowing characters can be entered:
- Up to 255 bytes
- Alphanumeric characters and hyphens (-)

• Text Box on the Right: Enter the port number.

[Password Required] This item appears when [Proxy Server] is enabled.
Specify whether to enable the password for proxy 
server authentication.
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[IPP]
You can configure the settings for IPP (Internet Printing Protocol).

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

[LPD]
You can configure the settings for LPD.

[Login Name] This item appears when [Password Required] is ena-
bled.
Enter the login name for proxy server authentication. A 
null cannot be set. The following characters can be en-
tered:
• Up to 31 bytes

[Password] This item appears when [Password Required] is ena-
bled.
Enter the login password for proxy server authentica-
tion. A null cannot be set. The following characters can 
be entered:
• Up to 31 bytes

[Retype Password] This item appears when [Password Required] is ena-
bled.
Enter the same character string in Password.

[Exception List] This item appears when [Proxy Server] is enabled.
Enter the address to bypass the proxy server. The fol-
lowing characters can be entered:
• IP address or FQDN (Fully Qualified Domain Name) 

format
• Up to 319 bytes

Setting Description

Setting Description

[Port] Specify whether to enable the IPP port to be used.

[Port Number] This item appears when [Port] is enabled.
Displays the IPP port number.

[Alternate Port Number (IPP)] This item appears when [Port] is enabled.
Enter the port number. The default value is "80".

Note
Do not use the same port number as other protocols.

[Alternate Port Number 
(IPPS)]

This item appears when [Port] is enabled.
Enter the port number. The default value is "443".

Note
Do not use the same port number as other protocols.

[Timeout] This item appears when [Port] is enabled.
Enter the connection timeout period of IPP. If the reception of data stops 
during the transfer, the connection to the printer is terminated after the 
time period specified here elapses.

Setting Description

[Port] Specify whether to enable the LPD protocol.

[Timeout] This item appears when [Port] is enabled.
Enter the connection timeout period of LPD protocol. If the reception of 
data stops during the transfer, the connection to the printer is terminated 
after the time period specified here elapses.
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[POP3]
You can configure the settings for POP3.

Setting Description

[IP Address/Host 
Name : Port]

Enter the address of the incoming e-mail server to be 
connected via POP3 protocol and the port number.
• Text Box on the Left: Enter the address of the in-

coming e-mail server to be connected via POP3 
protocol. The following characters can be entered:
- IP address or FQDN (Fully Qualified Domain 
Name) format
- Up to 63 bytes
- Alphanumeric characters, periods (.), and hy-
phens (-)

• Text Box on the Right: Enter the port number to be 
used on the POP3 server.

[Password Encryp-
tion]

Specify whether to encrypt the password.

[User Name] Enter the user name for the incoming e-mail server. 
The following characters can be entered:
• Up to 63 bytes
• Alphanumeric characters, periods (.), hyphens (-), 

underscores (_), and the @ mark

[Password] Enter the password for the incoming e-mail server. A 
null cannot be set. The following characters can be en-
tered:
• Up to 31 bytes
• Alphanumeric characters and symbols

[Retype Password] Enter the same character string in [Password].

[Polling Interval] Enter the time interval for polling.

[Permitted Email Address]

[Email Address 
1]/[Email Address 
2]/[Email Address 
3]/[Email Address 4]

To impose restrictions on e-mail reception, enter the 
e-mail addresses that you permit to receive e-mails 
from. If none is specified, all e-mails are permitted.
The following characters can be entered:
• Up to 31 bytes

[StatusMessenger Password]

[Password] Enter the password to access to the StatusMessenger 
function via an e-mail received. If you do not want to 
set the password, leave the text box blank. The follow-
ing characters can be entered:
• Up to 7 bytes
• Alphanumeric characters

[Retype Password] Enter the same character string in [Password].

[Print Job Password]

[Password] Enter the password when you print out the e-mail at-
tachments received by the printer. If you do not want 
to set the password, leave the text box blank. The fol-
lowing characters can be entered:
• Up to 7 bytes
• Alphanumeric characters

[Retype Password] Enter the same character string in [Password].
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[Port 9100]
You can configure the settings for Port9100.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

Setting Description

[Port] Specify whether to enable Port9100.

[Port Number] This item appears when [Port] is enabled.
Enter the Port9100 port number. The default value is "9100".

Note
Do not use the same port number as other protocols.

[Timeout] This item appears when [Port] is enabled.
Enter the connection timeout period of Port9100 protocol. If the recep-
tion of data stops during the transfer, the connection to the printer is ter-
minated after the time period specified here elapses.
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[SMTP]
You can configure the settings for SMTP.

Setting Description

[Email Notification] Specify whether to use the e-mail notification.

[Device Email] Enter the e-mail address of the printer. When you want 
to send e-mails to the printer, use this e-mail address. 
The e-mail address is also displayed after "From:" on 
e-mails sent from the printer. The following characters 
can be entered:
• Up to 63 bytes

[SMTP Server]

[Server Address] Enter the address of the outgoing e-mail server to be 
connected via SMTP protocol. The following charac-
ters can be entered:
• IP address or FQDN (Fully Qualified Domain Name) 

format
• Up to 63 bytes
• Alphanumeric characters, periods (.), and hyphens 

(-)

[Outgoing SMTP Port 
Number]

Enter the port number to be used on the SMTP server.

[Connection Security] Select the encryption type for SMTP communication.

Note
If the mail server does not support STARTTLS, com-
munication with the mail server cannot be established 
even when [STARTTLS] is selected.

[Outgoing SMTP Authentication]

[SMTP Authentica-
tion]

Select the login method to the SMTP server. For infor-
mation on which login method is used, contact your 
server administrator. If you do not use the login func-
tion, select [Off]. When [SMTP AUTH (AUTO)] is select-
ed, the printer automatically supports Plain, Login, and 
CRAM-MD5.

[SMTP AUTH User 
Name]

You can enter when SMTP AUTH is selected for 
[SMTP Authentication].
Enter the login user name for the SMTP server. The fol-
lowing characters can be entered:
• Up to 63 bytes
• Alphanumeric characters, periods (.), hyphens (-), 

underscores (_), and the @ mark

[SMTP AUTH Pass-
word]

You can enter when SMTP AUTH is selected for 
[SMTP Authentication].
Enter the login password for the SMTP server. A null 
cannot be set. The following characters can be en-
tered:
• Up to 31 bytes
• Alphanumeric characters and symbols

[Retype Password] You can enter when SMTP AUTH is selected for 
[SMTP Authentication].
Enter the same character string in [SMTP AUTH Pass-
word].

[Connection Test] Displays the results of connection test. Clicking [Exe-
cute] establishes connection with SMTP server.
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[SNMP]
You can configure the settings for SNMP (Simple Network Management Protocol).

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

- [SNMP v3] is available when [HTTP - SSL/TLS Communication] is enabled.

Setting Description

[Port] Specify whether to enable the SNMP proto-
col to be used.

[Send Authentication Error Traps] This item appears when [Port] is enabled.
Specify whether to notify when the authenti-
cation for SNMP fails.

[SNMP v1/v2] This item appears when [Port] is enabled.
Specify whether to enable SNMP v1/v2. To 
edit the settings, click the item name to dis-
play the [SNMP v1/v2] dialog box.

Note
This setting becomes available when you re-
start the printer from Internet Services or 
manually turn off and on the printer on the 
operator panel of the printer.

[Enable] Specify whether to enable SNMP v1/v2.

[Community Names] This item appears when SNMP v1/v2 is ena-
bled.

[Community 
Name Read On-
ly]

Enter a read only community name. The de-
fault community name is "public".

[Community 
Name 
Read/Write]

Enter a read/write community name. The de-
fault community name is "private".

[Trap Communi-
ty Name]

Enter a trap community name. The default 
community name is "SNMP_trap".

[Trap Destination] This item appears when SNMP v1/v2 is ena-
bled.
Lists the addresses of the destination to be 
notified of trap occurrences. Clicking the 
destination or [(Available)] displays the edit-
ing trap dialog box.

[IP Address : 
Port]

• Text Box on the Left: Enter the IP address 
according to [Type].

• Text Box on the Right: Enter the port 
number (UDP).

[Traps Commu-
nity Name]

Set the community name used when traps 
are sent.
Enter a string within 32 characters.

[Trap to be Re-
ceived]

Specify whether to notify trap occurrences.

[Traps to Be Re-
ceived]

For each item, set whether to notify of the oc-
currence of traps.
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[SNMP v3] This item appears when [Port] is enabled.
Specify whether to enable SNMP v3. To edit 
the settings, click the item name to display 
the SNMP v3 dialog box.

Note
This setting becomes available when you re-
start the printer from Internet Services or 
manually turn off and on the printer on the 
operator panel of the printer.

[Enable] Specify whether to enable SNMP v3.

[System Administrator Account] This item appears when SNMP v3 is enabled.
Specify whether to enable account access of 
the system administrator. Enabling account 
access of the system administrator enables 
the system administrator account.

[User Name] This item appears when account access of 
the system administrator is enabled.
Displays the user name of the system admin-
istrator.

[Message Digest 
Algorithm]

Select the message digest algorithm to use 
for the system administrator account.

[Authentication 
Password]

This item appears when account access of 
the system administrator is enabled.
Enter an authentication password. A null 
cannot be set. The following characters can 
be entered:
• Between 8 bytes and 32 bytes
• Alphanumeric characters and symbols

[Retype Pass-
word]

This item appears when account access of 
the system administrator is enabled.
Enter the same character string in [Authenti-
cation Password].

[Message En-
cryption Algo-
rithm]

Select the message encryption algorithm to 
use for the system administrator account.

[Encryption 
Password]

This item appears when account access of 
the system administrator is enabled.
Enter an encryption password. A null cannot 
be set. The following characters can be en-
tered:
• Between 8 bytes and 32 bytes
• Alphanumeric characters and symbols

[Retype Pass-
word]

This item appears when account access of 
the system administrator is enabled.
Enter the same character string in [Encryp-
tion Password].

[Print Drivers Account] Specify whether to enable account access of 
the print driver.

[Message Digest 
Algorithm]

Displays the message digest algorithm to be 
used for the system administrator account.
This item is displayed when the system ad-
ministrator account is enabled.

[Message En-
cryption Algo-
rithm]

Displays the message encryption algorithm 
to be used for the system administrator ac-
count.
This item is displayed when the system ad-
ministrator account is enabled.

[Reset to Default 
Password]

This item appears when account access of 
the print driver is enabled.
Resets the password to the default.

Setting Description
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[SNTP]
You can configure the settings for SNTP.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

[Web API]
Specify whether to enable web API.

[Web Services on Devices (WSD)]
You can configure the settings for WSD (Web Services on Devices).

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

Setting Description

[Time Server Synchroniza-
tion]

Specify whether to synchronize the printer with the time server.

[Time Server Address] This item appears when synchronizing the printer with the time server.
Enter the server address. The following characters can be entered:
• Up to 255 bytes
• Alphanumeric characters, periods (.), hyphens (-), and colons (:)

[Timeout] This item appears when synchronizing the printer with the time server.
Enter the timeout period to wait for a response from the server.

[Time Synchronization Inter-
val]

This item appears when synchronizing the printer with the time server.
Enter the time interval for synchronizing the time on the printer.

Setting Description

[WSD Print] Specify whether to enable the WSD Print function.

[Port Number] Enter the WSD port number. The default value is "80".

Note
Do not use the same port number as other protocols.

[Data Reception Timeout] Enter the connection timeout period of WSD. When the timeout period 
specified here elapses during data reception, the connection is terminat-
ed.

[Notification Delivery Time-
out]

Enter the connection timeout period of WSD. When the timeout period 
specified here elapses during notification delivery, the connection is ter-
minated.

[Maximum IP Packet TTL] Enter the maximum TTL of a WSD communication packet.

[Maximum Number of Sub-
scribers]

Enter the maximum number of WSD subscribers.
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12.5 Accounting
Describes the settings for copying accounting and printing restrictions on users.

Tips
This item appears when the following two conditions are satisfied:

- If you login as the system administrator when [Administrator Mode] in [Administrator Settings] is ena-
bled

- When [Print Accounting] is enabled from the operator panel of the printer

12.5.1 [Advanced Settings]
Clicking [Advanced Settings] > [Unauthenticated User Print] displays the [Unauthenticated User Print] dialog 
box.

[Unauthenticated User Print]
Specify whether to allow to print jobs without account information (user name and password). When [Restrict] 
is selected, jobs without account information cannot be printed.

The jobs without account information are the following:

- Jobs generated using other company's print drivers or utilities

- Jobs submitted using the following functions:

- USB Direct Print
- AirPrint
- Mopria® Print Service

Tips
- Even if our print driver or application is used, jobs generated with the print driver's or application's user 

authentication settings disabled are regarded as jobs without account information.

12.5.2 [User Accounts]
You can check the list of registered user accounts in the printer. To edit the settings of each user account, 
click the user name and display the details of the user dialog box.

[Add]
Displays the [Add New Account] dialog box.

Setting Description

[User Name] Enter the user name. The following characters can be entered:
• Up to 32 bytes
• Alphanumeric characters, symbols, and spaces

[Password] Enter the password. When you do not want to set the password, leave 
the text box blank. The following characters can be entered:
• Between 4 bytes and 12 bytes
• Alphanumeric characters, symbols, and spaces

[Retype Password] Enter the same character string in [Password].
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Details of the User
You can configure the settings for the users registered on the printer. You can also change the user pass-
words and delete the users.

Setting Description

[Change Password] Displays the [Change Password] dialog box.

[New Password] Enter the new password. If you do not want to set a 
password, leave the text box blank. The following 
characters can be entered:
• Between 4 bytes and 12 bytes
• Alphanumeric characters, symbols, and spaces

[Retype Password] Enter the same character string in [New Password].

[Delete User] Clicking [Delete] deletes the user information.

[Accounting]

[Prints] • [Color]: Displays the total number of color pages 
printed and the maximum number of color pages 
permitted to print.

• [Black & White]: Displays the total number of mon-
ochrome pages printed and the maximum number 
of monochrome pages permitted to print.

[Edit] Displays the [Edit Accounting] dialog box.

[Color Prints] Specify whether to restrict color printing.
• [Limit]

This item appears when Color Prints is permitted.
Enter the maximum number of color pages permit-
ted to print.

• [Used]
This item appears when Color Prints is permitted.
Displays the total number of color pages printed.

[Black & White Prints] • [Limit]
Enter the maximum number of monochrome pages 
permitted to print.

• [Used]
Displays the total number of monochrome pages 
printed.
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12.6 System
Describes the settings for security and the administrator.

Tips
- This item appears if you login as the system administrator when [Administrator Mode] in [Administrator 

Settings] is enabled.

12.6.1 [Security]
You can configure the settings of certificates and network security. You can edit each setting in the setting 
dialog box displayed by clicking the item name.

[Certificates]

[Security Certificates]
You can create, confirm, import, export, and delete the certificates.

No. Description

1 Select the category of certificates from the drop-down list box.

2 Select the operation for the certificates.
• [Import]: This item is available when [Device Certificates], [Trusted Root CA Certificates], 

[Intermediate CA Certificates], or [Other Certificates] is selected in the category of certif-
icates.

• [Create]: This item appears when Device Certificates is selected in the category of cer-
tificates. Creates the device certificates.

• [Delete]: Deletes the certificates selected in 4.

3 Selecting this item enables to select all the certificates displayed in 4. To deselect all the se-
lected items, click this item.

4 Lists the certificates selected in 1. Clicking each items of the certificates displays the Cer-
tificate Details dialog box.
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Certificate Details

dReference
For details refer to page 12-33.

[Automatic Self-Signed Certificate Creation]
You can specify whether to automatically create the self-signed certificates in the following cases:

- When there is no certificate of the printer

- When the expiration date of automatically updated certificates is approaching

Tips
- Manually created self-signed certificates are not automatically updated.

Setting Description

[Category] Displays the category of certificates.

[Subject/Issuer] Displays the subject and the issuer of the certificate. The issuer is as-
signed automatically based on the printer name and MAC address.

[Serial Number] Displays the serial number of the certificate.

[Digital Signature Algorithm] Displays the method of the hash algorithm.

[Public Key Length] Displays the length of the public key.

[Elliptic Curve] Displays the elliptic curve cryptography.

[Valid From] Displays the date that the created certificates become valid.

[Valid To] Displays the date that the created certificates become invalid.

[Validity] Displays the validity of the certificates.

[Certificate Use] Displays the purpose of use of the certificates.

[Selected Usage] Displays the usage of the certificates.

[Email Address] Displays the e-mail address for contact.

[Delete] Deletes the certificate displayed.

[Export] Exports the certificate displayed.
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[Network Security]

[SSL/TLS Settings]
You can specify the security on data sent and received by the printer.

The data that are subject to security protection are IPP print jobs, information exchanged between the printer 
and the web browser, or information exchanged between the printer and the server. These data are encrypt-
ed using SSL/TLS communication.

To access Internet Services when data encryption is enabled, enter "https" before its address instead of 
"http".

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

Setting Description

[Protocol Version] Set the version of TLS.

[Device Certificate - Server] Specify the certificates of the printer.

[HTTP - SSL/TLS Communi-
cation]

Specify whether to enable the SSL/TLS communication.

Note
When there is no certificate, [HTTP - SSL/TLS Communication] cannot 
be specified.

[HTTP - SSL/TLS Port Num-
ber]

Enter the port number that accepts requests from your web browser. 
The default value is "443".
When the port number is changed, enter a colon (:) and the port number 
after the printer's IP address, and then access to Internet Services with 
the format of 
"https://Printer_IP_Address:Port_Number/".
Example: https://192.0.2.1:80/

Note
Do not use the same port number as other protocols.

[SMTP - SSL/TLS Communi-
cation]

Select the encryption type for SMTP communication.

Note
If the mail server does not support STARTTLS, communication with the 
mail server cannot be established even when [STARTTLS] is selected.

[IPP - Only Over SSL/TLS] Specify whether to forcibly encrypt IPP using SSL/TLS communication.

[Verify Remote Server Certifi-
cate]

Specify whether to verify the certificates of the destination server.
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[IP Address Filtering]
You can specify the network that enable to access to the printer when limiting within the range of the specific 
IP addresses. Enter the IP addresses and subnet masks that you want the printer to control connections.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

[Domain Filtering]
You can specify the settings/destinations of e-mails configured on the operator panel of the printer when lim-
iting the specific domains.

[Authentication System]
You can configure the settings for the authentication method when using the authentication server.

Tips
- This setting becomes available when you restart the printer from Internet Services or manually turn off 

and on the printer on the operator panel of the printer.

Setting Description

[IPv4] Specify whether to enable only the specific IP ad-
dresses to access to the printer in the IPv4 environ-
ment.

[IPv6] Specify whether to enable only the specific IP ad-
dresses to access to the printer in the IPv6 environ-
ment.

[Allowed IP Ad-
dress/Subnet Mask]

This item appears when [IPv4 Address Filtering] or 
[IPv6 Address Filtering] is enabled. Lists the addresses 
that allowed to access. Clicking [Add] displays the ed-
iting IP address dialog box.
• [Enter IP Address]: Enter the IP address for each 

environment to allow to access.
• [Enter IP Mask]: Enter the range of the IP address 

for each environment to allow to access.

Setting Description

[Allow Specific Domains] Enter the domains to be allowed to send and receive e-mails. The fol-
lowing characters can be entered:
• Up to 64 bytes
• Alphanumeric characters, periods (.), and hyphens (-)

[Off] Does not apply restrictions about sending/receiving e-mails to any spe-
cific domains.

Setting Description

[Authentication Protocol] Select the authentication protocol to be used.

[Advanced Settings]

[Connection Timeout] Enter the timeout period to wait for a response from 
the server.

[Search Timeout] Enter the timeout period to search.
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12.6.2 Creating/Importing/Exporting/Deleting Certificates

Creating Certificates
The following procedure uses the case when the window size of the web browser is the large screen.

1 Click [Log In] on the upper right corner.

% If [Local User] is displayed on the upper right corner, move to step 3.

2 Enter [User Name] and [Password] for the system administrator, and then click [Log In].

% For details, refer to page 12-5.

3 Click [System] > [Security] > [Security Certificates].

The [Security Certificates] dialog box is displayed.

4 Select [Device Certificates] from the drop-down list box.

5 Click [Create].

6 Select [Create Self-Signed Certificate] or [Create Certificate Signing Request (CSR)].

When [Create Self-Signed] Certificate Is Selected

The [Create Self-Signed Certificate] dialog box is displayed.

% [Digital Signature Algorithm]: Select the method of the hash algorithm.

% [Public Key Length]: Select the length of the public key. 
This item is displayed when Digital Signature Algorithm is set to [RSA/SHA-256], [RSA/SHA-384] or 
[RSA/SHA-512].

% [Elliptic Curve]: Select the elliptic curve to use.
This item is displayed when [Digital Signature Algorithm] is set to [ECDSA/SHA-256], [ECDSA/SHA-
384] or [ECDSA/SHA-512].

% [Issuer]: Select the issuer of the certificate.

% [Validity Period]: Enter the effective time period of the created certificate.

When [Create Certificate Signing Request (CSR)] Is Selected

The [Create Certificate Signing Request (CSR)] dialog box is displayed.

% [Digital Signature Algorithm]: Select the method of the hash algorithm.

% [Public Key Length]: Select the length of the public key. 
This item is displayed when Digital Signature Algorithm is set to [RSA/SHA-1], [RSA/SHA-256], 
[RSA/SHA-384] or [RSA/SHA-512].

% [Elliptic Curve]: Select the elliptic curve to use. 
This item is displayed when Digital Signature Algorithm is set to [ECDSA/SHA-1], [ECDSA/SHA-
256], [ECDSA/SHA-384] or [ECDSA/SHA-512].

% [2-Letter Country Code (C)]: Enter your country code.

% [State/Province Name (ST)]: Enter the name of state or region where your organization is located. 
The following characters can be entered: 
- Up to 16 bytes 
- Alphanumeric characters, periods (.), and spaces

% [Locality Name (L)]: Enter the name of the city where your organization is located. The following 
characters can be entered:
- Up to 32 bytes
- Alphanumeric characters, periods (.), and spaces

% [Organization Name (O)]: Enter your organization name. The following characters can be entered:
- Up to 32 bytes
- Alphanumeric characters, periods (.), and spaces

% [Organization Unit (OU)]: Enter your organization unit name such as a division name. The following 
characters can be entered:
- Up to 32 bytes
- Alphanumeric characters, periods (.), and spaces

% [Common Name (CN)]: Displays the FQDN (Fully Qualified Domain Name) used for an SSL commu-
nication.

% [Email Address]: Displays the e-mail address to contact your organization.
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7 Click [Create].

The certificate is created.

Importing Certificates
The following procedure uses the case when the window size of the web browser is the large screen.

NOTICE
This function is available when [HTTP - SSL/TLS Communication] is enabled.

1 Click [Log In] on the upper right corner.

% If [Local User] is displayed on the upper right corner, move to step 3.

2 Enter [User Name] and [Password] for the system administrator, and then click [Log In].

% For details, refer to page 12-5.

3 Click [System] > [Security] > [Security Certificates].

The [Security Certificates] dialog box is displayed.

4 Select [Trusted Root CA Certificates], [Intermediate CA Certificates], or [Other Certificates] from the 
drop-down list box.

5 Click [Import].

The [Import Certificate] dialog box is displayed.

% Certificate File: Specify by entering the certificate file name to import or clicking [Select]. A null can-
not be set. The following characters can be entered:
- Up to 255 bytes

% [Password]: Enter the password for decrypting the certificate data. The following characters can be 
entered:
- Up to 36 bytes
- Alphanumeric characters and symbols

% [Retype Password]: Enter the same character string in Password.

6 Click [Import].

The certificate is imported.

Exporting Certificates
The following procedure uses the case when the window size of the web browser is the large screen.

1 Click [Log In] on the upper right corner.

% If [Local User] is displayed on the upper right corner, move to step 3.

2 Enter [User Name] and [Password] for the system administrator, and then click [Log In].

% For details, refer to page 12-5.

3 Click [System] > [Security] > [Security Certificates].

The [Security Certificates] dialog box is displayed.

4 Select the category of the certificate that you want to export from the drop-down list box.

The certificates are listed.

5 Select the certificate to export.

The [Certificate Details] dialog box is displayed.

6 Click [Export].

7 Save the certificate in the desired directory.
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Deleting Certificates
The following procedure uses the case when the window size of the web browser is the large screen.

1 Click [Log In] on the upper right corner.

% If [Local User] is displayed on the upper right corner, move to step 3.

2 Enter [User Name] and [Password] for the system administrator, and then click [Log In].

% For details, refer to page 12-5.

3 Click [System] > [Security] > [Security Certificates].

The [Security Certificates] dialog box is displayed.

4 Select the category of the certificate that you want to delete from the drop-down list box.

The certificates are listed.

5 Select the certificate to delete.

6 Click [Delete].

7 Confirm the message and click [Delete].

The certificate is deleted.

12.6.3 [Administrator Settings]
You can specify an ID and a password for the system administrator. Clicking the icon displays the [Adminis-
trator Settings] dialog box.

[Administrator Mode]
Specify whether to authenticate with the user name and the password for the system administrator when 
changing the administrative printer configuration.

Tips
- If you disable the [Administrator Mode], all users can change the settings of the printer.

[Login Name]
This item appears when [Administrator Mode] is enabled.

Enter the login name (user name) for the system administrator. A null cannot be set. Colons (:) are not avail-
able. The following characters can be entered:

- Up to 8 bytes

- Alphanumeric characters and symbols

[Password]
This item appears when [Administrator Mode] is enabled.

Enter the password for the system administrator. A null cannot be set. Colons (:) are not available. The fol-
lowing characters can be entered:

- Between 4 bytes and 128 bytes

- Alphanumeric characters and symbols

[Retype Password]
This item appears when [Administrator Mode] is enabled.

Enter the same character string in [Password].
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[Limit Login Attempts of System Administrator]
This item appears when [Administrator Mode] is enabled.

Specify whether to restrict the number of login attempts to be permitted as the system administrator.

[Failed Login Attempt Limit]
This item appears when [Limit Login Attempts of System Administrator] is enabled.

Enter the maximum number of login attempts to be permitted as the system administrator.

[Security Warning]
This item appears when [Administrator Mode] is enabled.

Specify whether to display the security warning in the following cases:

- When a global IP address is allocated on the printer, and both [User Name] and [Password] of the sys-
tem administrator are the default

- When a global IP address is allocated on the printer, and [Community Names] in the [SNMP v1/v2] di-
alog box is the default
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13.1 Specifications

Specifications

Printing Method LED Xerography

Note
LED + Xerographic

Warm-up Time 35 seconds or less (73.4 °F (23 °C) room temperature)
16.8 seconds or less from Sleep Mode

Continuous Print Speed Simplex
Letter: Color 33 ppm, B/W: 33 ppm
A4: Color 31 ppm, B/W: 31 ppm
A5: Color 41 ppm, B/W: 41 ppm
Duplex
Letter: Color 20 ppm, B/W: 20 ppm
A4: Color 19 ppm, B/W: 19 ppm
A5: Color 23 ppm, B/W: 23 ppm

Note
When Continuously Printing Original (Plain). The performance may be re-
duced depending on the paper type and the paper size. The speed may 
be reduced due to the image quality adjustment. Measured in accord-
ance to ISO/IEC 24734.

First Print Time Color: 11.0 seconds (Letter/A4), B/W: 10.0 seconds (Letter/A4)

Note
When feeding from feeder tray of machine and connecting USB. Numer-
ic value varies depending on output environment. Measured in accord-
ance to ISO/IEC 17629.

Resolution Standard
PCL Driver: 600x2400 dpi
PostScript language compatibility: 600x2400 dpi

Paper Size Standard Tray
Legal, Folio, Letter, Executive, A4, JIS B5, A5, A6, COM-10, Monarch, 
DL, C5, Postcard (4 x 6"), Postcard (5 x 7"), Custom Size (Width: 3 to 
8.5" (76.2 to 215.9 mm), Length: 5 to 14" (127.0 to 355.6 mm))
Bypass Tray
Legal, Folio, Letter, Executive, A4, JIS B5, A5, A6, COM-10, Monarch, 
DL, C5, Postcard (4 x 6"), Postcard (5 x 7"), Custom Size (Width: 3 to 
8.5" (76.2 to 215.9 mm), Length: 5 to 14" (127.0 to 355.6 mm))
Optional Tray
Paper Feed Unit PF-P26: Legal, Folio, Letter, Executive, A4, JIS B5, A5, 
Custom Size (Width: 3 to 8.5" (76.2 to 215.9 mm), Length: 8.27 to 14" 
(210.0 to 355.6 mm))
2 Sided Printing
Legal, Letter, Executive, A4, JIS B5, A5, Custom Size (Width: 5.47 to 8.5" 
(139.0 to 215.9 mm), Length: 8.27 to 14" (210.0 to 355.6 mm))

Paper Weight Standard Tray: 15.96 to 46.82 lb (60 to 176 gsm)
Bypass Tray: 15.96 to 46.82 lb (60 to 176 gsm)
Optional Tray (Paper Feed Unit PF-P26): 15.96 to 46.82 lb (60 to 
176 gsm)
2 Sided Printing: 15.96 to 46.82 lb (60 to 176 gsm)

Note
It is recommended to use our recommended paper. Correct print output 
may not be possible depending on the requirement.
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Paper Tray Capacity Standard
Standard Tray: 250 sheets, Bypass Tray: 50 sheets
Optional
Paper Feed Unit PF-P26: 250 sheets
Max
550 sheets (Standard + Optional)

Note
21.28 lb (80 gsm) paper

Output Tray Capacity 150 sheets (Face down)

Note
21.28 lb (80 gsm) paper

Memory Capacity 512 MB (Max: 512 MB)

Page Description Language Standard
PCL5 / PCL6, PostScript language compatibility

Operating System Standard
PCL Driver:
Windows 11 (64 bit)
Windows 10 (32 bit/64bit)
Windows 8.1 (32 bit/64bit)
Windows Server 2022 (64 bit)
Windows Server 2019 (64 bit)
Windows Server 2016 (64 bit)
Windows Server 2012 R2 (64 bit)
Windows Server 2012 (64 bit)
PostScript language compatibility:
Windows 11 (64 bit)
Windows 10 (32 bit/64bit)
Windows 8.1 (32 bit/64bit)
Windows Server 2022 (64 bit)
Windows Server 2019 (64 bit)
Windows Server 2016 (64 bit)
Windows Server 2012 R2 (64 bit)
Windows Server 2012 (64 bit)
macOS  12 / 11 / 10.15 / 10.14 / 10.13

Note
For information about the latest supported OS, visit our web site.

Interface Standard
Ethernet 1000BASE-T / 100BASE-TX / 10BASE-T, USB2.0, Wireless 
LAN (IEEE 802.11 b / g / n)

Network Protocol*1 TCP/IP (lpd, IPP/IPPS, Port9100, WSD)

Power Supply AC110 to 127 V +/- 10%, 12 A, 50/60 Hz common (AC220 to 240 V +/- 
10%, 10 A, 50/60 Hz common)

Noise In Operation: 6.99 B, 50.7 dB (A)
Ready Mode: Noise-free

Note
Measured in accordance to ISO7779. Unit B: Sound Power Level LWAd. 
Unit dB: Radiated Sound Pressure Level LpAm (bystander position). 
"Noise-free" refers to Radiated Sound Pressure Levels equal to or below 
ISO 7779 background noise absolute standards for each bystander po-
sition.

Specifications
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*1: The machine does not support assigning printer names using a NetBIOS name. Use an IP address or 
FQDN when assigning.

Maximum Power Consump-
tion

• AC110 to 127 V
Max
920 W
Sleep Mode
0.4 W
Average
Ready Mode: 37 W, In Operation: 493 W

• AC220 to 240 V
Max
1110 W
Sleep Mode
0.5 W
Average
Ready Mode: 37 W, In Operation: 407 W

Dimensions (Width e depth e 
height)

16.14 e 16.93 e 10.04" (410 e 430 e 255 mm)

Weight 38.36 lb (17.4 kg) (Including consumables and drum)

Specifications
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13.2 About Supplies

13.2.1 Life of Consumables
Use of consumables/periodical replacement parts not recommended by us may impair machine quality and 
performance. Use only consumables/periodical replacement parts recommended by us.

13.3 Updating the Machine's Firmware
You can use a computer to update the machine's firmware (the software programmed into the machine). To 
download the firmware updating tool, access the Konica Minolta web site in your region, or contact your sup-
plier.

For more information on updating the machine’s firmware, please refer to the file 
readme_updating-firmware.txt provided with the downloaded firmware.

Consumables Printable page yield

Toner TNP93K Approximately 6000 pages

Toner TNP93C Approximately 4000 pages

Toner TNP93M Approximately 4000 pages

Toner TNP93Y Approximately 4000 pages

Drum DR-P02 Approximately 50000 pages

Waste Toner Bottle WB-P11 Approximately 6000 pages
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13.4 Uninstalling Software for Windows
Software installed using Printer Software can be uninstalled from the computer by removing the software in-
dividually.

Deleting the Print Driver
The print driver can be deleted from the [Devices and Printers] screen.

1 Click on [Start] > [Windows System] > [Control Panel] > [View devices and printers].

2 Right-click the printer icon of the driver to be deleted, and select [Remove device].

3 Click [Yes] on the confirmation screen.

4 After selecting any printer, select [Print server properties] to display [Print server properties].

([Print server properties] will not appear if a printer is not selected.)

5 Select the [Drivers] tab, and click [Change Driver Settings].

6 Select the driver to be deleted, and click [Remove].

7 Select the [Remove driver and driver package.], and click [OK].

8 Click [Yes] on the confirmation screen.

9 Click [Delete].

10 Click [OK].

11 Repeat steps 2 - 10 until the target printers are gone from the [Drivers] tab of [Print server properties].

12 Restart the computer.

Deleting Other Software
Delete the scanner driver, Print & Scan Hub, and Address Book Editor from the [Programs and Features] 
screen.

1 Click on [Start] > [Windows System] > [Control Panel] > [Uninstall a program].

2 Select the software to be deleted, and click [Uninstall].

3 If the confirmation screen appears, click [Yes].

4 Follow the on-screen instructions to proceed with the deletion.

5 Repeat steps 2 - 4 until the target software is gone from [Programs and Features].

6 Restart the computer.
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13.5 Open Source Licensing Remarks
This machine uses open-source software. For the open source licensing remarks, refer to the OSS-License-
file. 
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